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Safety Notice

Read all product manuals and consult with Beckman Coulter-trained personnel before attempting 
to operate the instrument. Do not attempt to perform any procedure before carefully reading all 
instructions. Always follow product labeling and manufacturer’s recommendations. If in doubt as 
to how to proceed in any situation, contact your Beckman Coulter Representative.

Alerts for Danger, Warning, Caution, Important, and Note

DANGER

DANGER indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury. This signal word is to be limited to the most 
extreme situations.

WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury. May be used to indicate the possibility of 
erroneous data that could result in an incorrect diagnosis (does not apply to all 
products).

CAUTION

CAUTION indicates a potentially hazardous situation, which, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe 
practices. May be used to indicate the possibility of erroneous data that could 
result in an incorrect diagnosis (does not apply to all products).

IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 
Following the advice in the Important adds benefit to the performance of a piece of equipment or to a 
process.

NOTE NOTE is used to call attention to notable information that should be followed during installation, use, 
or servicing of this equipment.
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Precautions for Use of This Equipment  
Precautions for Use of This Equipment

Check the following prior to using this equipment:

 • Check the outside of the equipment for damage, and check the inside of the equipment for 
foreign materials.

 • Check the contact points, such as the position of the switches, and confirm that the equipment 
is functioning properly.

 • Ensure that the equipment is properly grounded.

 • Confirm that all cords are plugged in properly.

Check the following while using the equipment:

 • Constantly monitor the entire equipment for the presence of foreign materials.

 • Do not touch any moving parts aside from parts indicated by labeling.

 • If foreign materials are discovered in the equipment, take appropriate measures, such as 
following the markings to stop the equipment.

 • Do not use devices that communicate with radio waves near this equipment.

 • When using this equipment, pay attention to the instructions on the warning labels attached to 
the equipment. See Labels.

Check the following after using this equipment:

 • Maintain properly after use.

 • Check for spills and debris in the sample compartment.

Check the following regarding the storage location:

 • Avoid tilting, vibrating, or striking the equipment (even during transport), and maintain in a 
steady state.

 • Store in a dry location.

 • Store in a location free from extreme fluctuations in air pressure.

If the equipment malfunctions, immediately stop operations and contact Beckman Coulter Field 
Service.
B08631AAvi
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Precautions for Use of This Equipment  
Labels

Laser Product Identification Label (Rear Panel of DelsaNano)

Class 1 Laser Product Label (Rear Panel of DelsaNano)

Class 3B Service Laser Label (Inside DelsaNano Sample Area Lid)
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Safety Notice
Precautions for Use of This Equipment  
Hot Surface Warning Label (Inside DelsaNano Sample Area)
B08631AAviii



Safety Notice
Specifications  
Specifications

Bench Dimensions (minimum requirements)
Width (with DelsaNano Auto Titrator): 152.4 cm (5 ft)
Width (without DelsaNano Auto Titrator): 91.4 cm (3 ft)
Depth: 61 cm (2 ft)
Height: 61 cm (2 ft)
Supportable weight: 68 kg (150 lbs)

DelsaNano Dimensions
DelsaNano C: 380 mm W  550 mm D  212 mm H (15 in W  21.7 in D ´ 8.3 in H)
DelsaNano S: 380 mm W  550 mm D  212 mm H (15 in W  21.7 in D ´ 8.3 in H)
DelsaNano HC: 380 mm W  550 mm D  212 mm H (15 in W  21.7 in D ´ 8.3 in H)
DelsaNano Z: 380 mm W  550 mm D  212 mm H (15 in W  21.7 in D ´ 8.3 in H)
DelsaNano AT: 250 mm W  310 mm D  290 mm H (9.8 in W  12.2 in D ´ 11.4 in H)

Weight
DelsaNano C: Approx. 21 kg (46.3 lbs)
DelsaNano S: Approx. 20 kg (44.1 lbs)
DelsaNano HC: Approx. 21 kg (46.3 lbs)
DelsaNano Z: Approx 21 kg (46.3 lbs)
DelsaNano AT: Approx. 7.5 kg (16.5 lbs)

Environment
Ambient operating temperature range: 15 C to 35 C (59 F to 95 F)
Recommended ambient temperature operating range: 15 C to 30 C (59 F to 86 F) with 
minimal temperature fluctuation

Relative Humidity
30-80% (without condensation)

Power requirements
100–120 or 220–240 VAC, 50–60 Hz, single phase
250 VA (rated input power). Neutral to ground: <0.5 V Electrical Supply, Class 1

Fuses
100-120 V   Current: T4A; Voltage: 125 V
220-240 V   Current: T2A; Voltage: 250 V

Altitude restrictions
Up to 2000 m (6562 ft)

Location restrictions
Indoor use only

Installation category
Category II

Pollution degree
2
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B08631AA ix



Safety Notice
Specifications  
Class 1 for operation (no access to radiation)
Class 3B for service and maintenance (trained Beckman Coulter personnel only)

Ventilation clearances (minimum requirements)
12.7 cm (5 in) on all sides of the instrument and controller

Nitrogen requirements (if measurements will be performed at 15 C or less)
Nitrogen air, maximum 10 psi
Tubing 4-mm OD, 2.5-mm ID, soft nylon
(Tubing length depends on the distance between the DelsaNano instrument and the nitrogen 
source.)
B08631AAx
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Introduction
Particle Sizing by Dynamic Light Scattering

Particles in Brownian Motion

Particles suspended in liquids are in Brownian motion due to random collisions with solvent 
molecules. This motion causes the particles to diffuse through the medium. The diffusion 
coefficient, D, is inversely proportional to the particle size according to the Stokes-Einstein 
equation:

Equation 1

D:   diffusion coefficient
kB: Boltzmann’s constant
T:   absolute temperature
0: viscosity
d:   hydrodynamic diameter

This equation shows that, for large particles, D will be relatively small, and, thus, the particles will 
move slowly while for smaller particles, D will be larger and the particles will move more rapidly. 
Therefore, by observing the motion and determining the diffusion coefficient of particles in liquid 
media, it is possible to determine their size.

Light Scattering From Particles in Brownian Motion

In dynamic light scattering, the fluctuations in time of scattered light from particles in Brownian 
motion are measured, photon correlation spectroscopy after dynamic light scattering. Figure 1 
shows schematically how particle size and distributions are determined by the dynamic light 
scattering method.

When laser light is directed onto the particles, light is scattered in all directions. The scattered light 
that is observed comes from a collection of scattering elements within a scattering volume that is 
defined by the scattering angle and detection apertures. The observed intensity of the scattered 
light at any instant will be a result of the interference of light scattered by each element; and thus, 
B08631AA xxv
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will depend on the relative positions of the elements. If the particles are in motion, the relative 
positions of particles will change in time; and thus, fluctuations in time of the scattered light 
intensity will be observed.

Because particles in Brownian motion move about randomly, the scattered intensity fluctuations 
are random. The fluctuations will occur rapidly for smaller, faster moving particles and more slowly 
for larger, slower moving particles. The fluctuations of the scattered light are analyzed using the 
autocorrelation function.

Figure 1  Determination of Particle Size by Dynamic Light Scattering

The Autocorrelation Function for Size Measurement

The calculation of the autocorrelation function G(2)() is one method of analyzing time dependent 
signals such as the random intensity fluctuation in Figure 2.

Equation 2

g(2)():  normalized intensity autocorrelation function
I(t):        intensity detected at time t
:           delay time
<I(t)>2:  nomalization factor
< >:         time average

For intensity fluctuations that are random, it can be noted that signals that are close to each other 
in time (small ) are also close to each other in value and can be said to have high correlation, while 
B08631AAxxvi
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signals that are far apart (large ) are different in value and can be said to have low correlation. The 
autocorrelation function will, thus, be a function that decays as a function of delay time ().

In the case of particles in Brownian motion, the normalized intensity autocorrelation function, 
g(2)(), will be an exponential function or a sum of exponentials. For further analysis, it is useful to 
convert the intensity autocorrelation function to the autocorrelation function of the electric field 
of the scattered light g(1)() by using the Siegert relationship:

Equation 3

If all the particles in the scattering volume are of the same size (monodisperse), g(1)() will be a 
single exponential:

Equation 4

where B is a constant dependent on instrumental parameters, such as the aperture (pinhole) size, 
and  is the decay constant which is proportional to the diffusion coefficient:

Equation 5

D: diffusion coefficient
q: magnitude of the scattering vector ( =4nsin(/2)/), where:
n: refractive index of media
: wavelength of incident light
: scattering angle

For small particles with rapid motion and rapid intensity fluctuations, the autocorrelation function 
is a rapidly decaying exponential function with a large decay constant, while for large particles the 
exponential decays more slowly with a smaller decay constant. It should also be noted that  is a 
function of the scattering angle and that the higher the angle, the faster the decay and lower the 
angle, the slower the decay of the correlation function.

For a mixture of particles (polydisperse), the intensity fluctuations will be due to particles differing 
in diffusion coefficients; therefore, autocorrelation will be a sum (or integral) of exponentials with 
differing decay constants:

Equation 6

Here, Ai is the relative intensity of light scattered by a particle with decay constant i and is related 
to relative amount of such particles.
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Figure 2  Log Correlator for Size Measurement 

Figure 3  Linear Correlator for Size Measurement
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Correlator

Two correlators are included in the instrument. One correlator is based on a log-scale decay time, 
and the other correlator is based on a linear-scale time. The log-scale correlator covers the range of 
six orders of decay time; thus, it can be adapted for most particles. On the other hand, the linear-
scale correlator has high resolution within the limited range of decay time; it is suitable for very 
small particles of narrow distribution.

The Correlation Method

During a sample run, the scattered light intensity is collected as a data train of photon pulses per 
sampling time , or sampling times (number of clock pulses) between two photon pulses. The 
former method is called the Time Domain (TD) method and the latter is called the Time Interval (TI) 
method. The length of the data train is specified by the parameter. The correlation function is then 
calculated for a specified number (channel number) of multiples of sampling times. The process is 
repeated for a number of times (accumulation times) and the correlation function is summed to 
reduce contributions due to noise.

The Time Domain Method

In the Time Domain (TD) method, the number of photon pulses between sampling times are 
collected. The calculation of TD method is a straightforward application of Equation 7.

The TD method is advantageous when the photon counts per sampling time is large; that is, for large 
particles with strong scattering levels and slowly decaying correlation functions that require larger 
sampling times.

The Time Interval Method

For very small particles that diffuse quickly, sampling times short enough to capture the rapid 
fluctuations are needed. But such particles usually scatter weakly and the situation is such that the 
photon counts per sampling time become very low. In this case, the TD method is an inefficient 
means of data collection. In the Time Interval (TI) method, the number of sampling times (clock 
pulses) between two photon pulses are collected as data and allows for more efficient 
determinations of the autocorrelation function for low-signal levels. In this method, the frequency 
distribution of time intervals between photon pulses (the total number of photon pulse pairs that 
are  apart, 2 apart, and so on) is determined to obtain the autocorrelation function.

Having both TI and TD methods allows for the observation of a wide range of particle sizes and 
applicability. The large number of channels is important for analyzing a mixture of small particles 
or to fully capture the movement of large particles.

Determining Particle Size/Size Distributions

The Cumulants Method

For monodisperse particles, it can be seen from Equation 4 that the logarithm of g(1)() will become 
a straight line. For polydisperse samples, the logarithm of g(1)() will exhibit a curvature line.
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In the Cumulants method, one fits the logarithm of g(1)() to a polynominal in  to determine the 
coefficients, Km:

Equation 7

The first order coefficient (or the slope of ln(g(1)()) is the average decay constant, <>, from which 
the average diffusion coefficient and particle diameter can be calculated by use of Equation 5 and 
Equation 1.

The second order coefficient divided by the square of <> is the polydispersity index, ( <(-<> )2> /
<> )2 ). The value of the polydispersity index is low, typically smaller than 0.1, for monodisperse 

samples and become larger for polydisperse samples.

The Methods for Particle Size Distribution

There are three methods included in the program to resolve particle size distributions from the 
measured autocorrelation functions.

 • The CONTIN Method

The well-documented computation routine known as CONTIN utilizes regularized non-
negative least-squares technique combined with eigenfunction analysis. It has been 
implemented as the main data retrieval algorithm. CONTIN uses a non-linear statistical 
technique to smooth the solution and reduce the number of degrees of freedom to an 
acceptable level. Users must specify the distribution range, the number of data points, and 
other constants. The regularization parameter can be automatically chosen. CONTIN considers 
account the weighting of the distribution, due to the use of discrete data points in the 
continuous distribution, and then calculates different moments of the computed distribution.

 • The Marquardt Method

The Marquardt method is an iterative method in which an initial “guess” is repeatedly 
processed to give a final answer. In the analysis program, the initial “guess” is a histogram with 
all the steps being of equal height. The algorithm is repeated to change the histogram to fit the 
raw data. The number of times the algorithm is repeated is the step number. The lambda 
parameter adjusts how much the answer changes in one step; if it is small the answer changes 
rapidly, if it is large, the answer changes slowly. Distributions obtained by this method tend to 
be broad and have connected peaks.

 • The Non-Negative Least-Squares (NNLS) Method

This is a least-squares algorithm which solves the matrix so that only positive values for Ai are 
obtained (in the Marquardt algorithm, negative values of Ai may be obtained but the values are 
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set to “0” when this happens). Distributions obtained by this method tend to have narrow and 
separated peaks.

Molecular Weight (MW) Analysis

The Molecular Weight (MW) analysis is performed for all types of particle size distributions. In the 
Cumulants analysis, the average diameter is converted into MW. The MW analysis requires that you 
enter two sample-dependent parameters, a and b, in order to calculate MW. The transformation 
equation for mean molecular weight is as follows:

Equation 8

where D is the diffusion coefficient as defined in Equation 1.

Zeta Potential Determination by Electrophoretic Light Scattering

Electrical Double Layer

Most particles dispersed in a liquid have positive or negative charge. In a liquid, the ions that have 
opposite charge to the particle surface gather close to the particle to keep an electric neutrality. 
Because the particle surface is surrounded by such ion clusters, ionized layers with opposite charge 
surround the layer on the surface of a particle (Figure 4). This phenomenon is expressed as an 
“electrical double layer.”

Figure 4  Schematic Diagram of Electrical Double Layer

Because the ion in a liquid moves by thermal diffusion, concentration of the counter ion is high in 
the area near the particle’s surface and gradually decreases with distance from the surface. Equal 
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numbers of positive and negative ions exist in the area far from the particle’s surface so that electric 
neutrality is maintained. This ion distribution is called a “diffuse electrical double layer.” The diffuse 
electrical double layer can be divided into two layers:

 • The layer of ions near the particle surface is called the “Stern layer.” The ions in the Stern layer 
are strongly attracted to the surface of the particle.

 • The layer outside the Stern layer is called the diffuse layer. In this layer, the ions are diffused.

Zeta Potential

The stability of the dispersing particles is influenced by their surface charge. Zeta potential is used 
as the index of the surface charge of the particles. It is assumed that the particles undergoing 
Brownian motion in a liquid move not only with the ions in the Stern layer where the ions are 
attracted strongly near the particle surface but also with part of the diffuse layer. The field from 
which this movement takes place is called the “slipping plane.” Zeta potential is considered to be 
the potential at the slipping plane and the potential at the position far from the particle surface is 
defined as zero (Figure 5). If zeta potential is high, the particles are stable due to high electrostatic 
repulsion between particles. On the contrary, a low zeta potential value (approaching zero) 
increases the probability of particles colliding; therefore, forming particle aggregates. Thus, zeta 
potential is used as an index of the dispersion stability of particles.

Figure 5  Concept of Zeta Potential
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Electrophoretic Light Scattering

When an electric field is applied to charged particles in the suspension, particles move toward an 
electrode opposite to its surface charge. Because the velocity is proportional to the amount of 
charge of the particles, zeta potential can be estimated by measuring the velocity of the particles. 
Electrophoretic light scattering is the method most generally used to determine the velocity of the 
particles. To determine the speed of the particles movement, the particles are irradiated with a laser 
light, and the scattered light emitted from the particles is detected. Because the frequency of the 
scattered light is shifted from the incident light in proportion to the speed of the particles 
movement, the electrophoretic mobility of the particles can be measured from the frequency shift 
of the scattered light. This method is based on the Doppler effect; therefore, it is also called the 
“Laser Doppler Method.”

Figure 6 displays the optical path of the DelsaNano. When measuring zeta potential, the DelsaNano 
detects the scattered light from the particles by combining incident light (reference light) with the 
scattered light. Because the intensity fluctuation of the combined light is equivalent to the 
frequency difference between the scattered and incident light observed, it is possible to precisely 
measure small frequency shifts. The incidence light is also used for particle size measurement.

The amount of frequency shift D of scattered light is related to the mobility of particles, U:

Equation 9

where q is the scattering vector and q = 4nsin(/2)/.  is the wavelength of the incident light, n 
is the refractive index of a medium, and  is the scattering angle. In many aqueous solutions 
containing an electrolyte, zeta potential can be calculated from the Smoluchowski equation.

Equation 10

Where 0 and r are dielectric constants in vacuo and of the solvent, respectively.

U
r



0


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Figure 6  Optical Diagram of DelsaNano C and HC
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The Power Spectrum for Zeta Potential Measurement

Power Spectrum analysis provides an easy and direct way to obtain electrophoretic mobility 
information.* The instrument acquires the ACF first and then converts into power spectrum by the 
Fourier transformation (Figure 7).

In the distribution graph (Figure 8), the Brownian motion of the particles is characterized by a 
Lorentzian peak, centered at a frequency shift that characterizes electrophoretic mobility of the 
particles.

If the sample is a mixture of particles of different mobility, for example, 2, then 2 peaks can be 
selected for Lorentzian fit.

Figure 7  ACF and Power Spectrum of Base Measurement

* Renliang Xu, Particle Characterization: Light Scattering Methods (Particle Technology Series)
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Figure 8  ACF and Power Spectrum of Test Measurement

Figure 9  ACF and Power Spectrum of Sample Zeta Potential Measurement

NOTE In Figure 9, the blue line indicates raw data; the red curve indicates fitted data; and 1 indicates the 
Lorentzian fit.
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Zeta Potential Measurement Using Electrophoretic Light Scattering

Most colloidal particles have an electrical charge on their surface when dispersed in liquids. The 
particles move towards the electrode that has an opposite charge if an electric field is applied to the 
cell that contains the particle suspension. Besides the particle movement, electroosmotic flow is 
also induced in the cell due to the surface charge of the cell wall. Because the cell is typically a closed 
system, electroosmotic flow occurring at the position close to the cell wall moves towards the 
opposite electrode, then hits the side wall of the cell, and flows back to the center of the cell. When 
measuring the zeta potential of the particles, an apparent mobility of the particles, which is equal 
to the sum of the electroosmotic flow and particle true mobility, is observed. See Figure 10.

Figure 10  Schematic Diagram of the Electroosmotic Flow Occurring in a Close Cell

(a) is the electroosmotic flow
(b) is the electroosmotic flow and particle true mobility

Electroosmotic flow has a symmetric parabolic profile when the particle concentration in the cell is 
homogeneous and the electrical charges on the upper and lower surfaces of the cell are equal. 
However, electroosmotic flow is asymmetric in many cases due to the sedimentation of particles, 
differences in the charges of the upper and lower cell surfaces, or for other reasons. Mori and 
Okamoto expanded Komaga’s model to generate an equation that can be applied to both symmetric 
and asymmetric osmotic flows.

Figure 11  Boundary Condition of the Electroosmotic Flow in the Cell

Assume the velocity of the electroosmotic flow at upper and lower surfaces of the cell is W1 and W0, 
respectively. The cross-sectional dimensions of the rectangular cell as 2a (X axis) and 2b (Z axis), 
with a>b, as shown in Figure 11. The electrophoretic mobility of the particles is the ratio of velocity 
of the particles to the electric field strength. The apparent mobility (x, z) of the particles can be 
represented as the sum of true mobility and electroosmotic flow, where the velocity of 
electroosmotic flow changes linearly from W1 to W0 in the Z direction on the sides of the cell.
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Equation 11

obs is apparent mobility
p is particle true mobility
(x, z) is the electroosmotic flow variation in z direction

Electroosmotic flow in Z direction (0, z,) is:

Equation 12

where:

where:

0 is the average of electroosmotic flow at upper and lower surfaces of the cell (0=(W1+W0)/2), 0 
is the difference of electroosmotic flow between upper and lower surfaces of the cell (0=W1+W0).

Hence, apparent particle mobility obs(0, z) transforms into:

Equation 13

Equation 13 indicates that nobs(0, z) is quadratic expression in (zi=z/b).

Equation 14

where:

Thus, 0, 0, and p can be calculated from the coefficients K0~K2 in Equation 14 if least square 
fitting is applied to obs(0, z) observed from a different position in z direction.

Zeta potential of a flat surface sample can be determined from Equation 12 to Equation 14 using a 
flat surface cell (Figure 12) in which the surface of the sample is the upper wall component of the 
cell.
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Figure 12  Schematic Diagram of the Flat Surface Cell and Apparent Particle Mobility in the Cell

Electroosmotic flow becomes asymmetric in this cell due to the difference in the surface charges of 
upper and lower surfaces of the cell. However, the Mori and Okamoto equation described above can 
be applied to this cell to determine the velocity of electroosmotic flow at upper (sample) surface W1 
as:

Equation 15

W1 can also be calculated from Equation 15 by subtracting true mobility from apparent mobility for 
the position z=b; i.e., obs(0, b). From W1, the surface zeta potential of the sample is calculated by 
using Smolochowski equation.
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CHAPTER 1

Operation
Introduction

The DelsaNano models are as follows:

 • DelsaNano S (A53876) measures the particle size of samples in suspension in a range from 
0.6 nm to 7 m. Samples may be concentrated or dilute.

 • DelsaNano C (A53878) measures the particle size of samples in suspension in a range from 
0.6 nm to 7 m. Samples may be concentrated or dilute. In addition, zeta potential 
measurements on dilute, concentrated samples, as well as solid flat surface materials.

 • DelsaNano HC (A53879) measures the particle size of samples in suspension in a range from 
0.6 nm to 7 m at a higher sensitivity. Samples may be concentrated or dilute. In addition, high 
sensitivity zeta potential measurements on dilute, concentrated samples, as well as solid flat 
surface materials.

 • DelsaNano Z (A53877) measures the zeta potential of samples in suspension in a range from 
0.6 nm to 30 m. Samples may be concentrated or dilute.

 • DelsaNano Auto Titrator (AT) (A53880) is an optional accessory for use with all DelsaNano 
models. It provides automatic three titration modes, pH titration in the range from 1 to 13, and 
additive and circulation titrations.

NOTE This manual applies to all DelsaNano models. If you are using a DelsaNano S system, the section 
related to zeta potential is not applicable to your configuration.
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Powering on the Equipment

To power on the components:

1 Turn the power switch to the On position. The switch is located on the left rear of the 
DelsaNano.

NOTE Turn the power on at least 30 minutes prior to starting the measurements. It takes approximately 
30 minutes for the laser to stabilize before taking measurements.

2 Observe the LEDs located on the top panel of the DelsaNano. During startup, the power LED on 
the DelsaNano will turn orange. Startup is complete when the LED turns green, enabling 
communications with the PC.

Figure 1.1  Power LED on DelsaNano

3 Turn on the PC.

Starting the Software

To start the software:

1 From Windows, double-click the DelsaNano icon on the desktop, or select the program from 
your program list.

 • If Security is set to “No Security” (default), after a brief initialization process, the software 
is ready for use.

 • If Security is set to “Security” or “21 CFR Part 11,” a login screen appears. (For information 
on Security, see Setting Security.)
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Figure 1.2  Security Login Dialog

2 Enter a user ID and password, and click OK. After a brief initialization process, the software is 
ready for use.

When the software is ready for use, the DelsaNano main screen appears (Figure 1.3). It contains 
several panels with functions that allow you to prepare for measurements.

Figure 1.3  DelsaNano Main Screen
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Table 1.1  DelsaNano Main Screen Elements

Screen Element Description

A Main Menu Bar For information on the menus on the menu bar, see Using the Main 
Menu Bar.

B SOP Designer Toolbar Contains two buttons:

 • Size SOP Designer is used to create and view SOPs for size 
measurement.

 • Zeta SOP Designer is used to create and view SOPs for zeta 
potential measurement.

C Button Bar This button bar is not present in all screens. When it is present, the 
buttons that appear on the bar apply to the selected function or 
screen. For example, when you select the Measurement function 
icon in the Data Acquisition function panel, the following buttons 
appear:

 • Start turns green when the instrument is connected.
 • Stop turns red when the instrument is measuring.

 • Add to Measuring SOP is used to add either size or zeta SOP 
to measuring SOP.

 • Remove is used to remove the size or zeta SOP used for 
measurement from the measuring SOP.

 • Connect is used to initialize the instrument, which must be 
turned on.

 • SOP Preview Print is used to print an SOP.

When you select the Security function panel, the following buttons 
appear:

 • Add New User is used to add a new user.
 • Edit User Profile is used to edit an existing user’s profile.
 • Delete User is used to delete a user. This button is replaced by 

the following when 21 CFR Part 11 security is enabled:
— Disable User is used to disable a user’s login.
— Enable User is used to enable a user to log into the 

DelsaNano software.

Other buttons appear in the function panel as appropriate.

When you are working in an SOP Designer, this button bar is not 
available. Instead, a different button bar appears inside each panel 
in the SOP Designer.
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D Function Icons Panel This panel contains the main software functions. Select a function 
name to open the corresponding set of task icons:

 • Data Acquisition function icon: Measurement
 • Size Analysis function icons: Analysis, QC, pH Analysis
 • Zeta Analysis function icons: Analysis, QC, pH Analysis, Low 

Conductivity Cell Analysis
 • pH Maintenance function icons: Configuration, pH Calibration, 

Priming, Consumable Check, Sample Circulation, pH Monitor
 • Maintenance function icon: System Configuration
 • Security function icons: User Management, Security Settings, 

and Data Mirroring

E Measuring SOP Listing This panel displays the SOP that will be used in the measurement.

F Particle Size SOP Listing This panel/tab displays the registered particle size measurement 
SOPs.

G Zeta Potential SOP Listing This panel/tab displays the registered zeta potential measurement 
SOPs.

H SOP Preview This panel displays the parameters within a selected SOP. To 
display the parameters of an SOP, select the SOP in the SOP 
Listing.

Table 1.1  DelsaNano Main Screen Elements (Continued)

Screen Element Description
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Using the Main Menu Bar

The Main menu bar and its drop-down menu items change based on the Security settings. All 
available menu commands per menu are listed in Table 1.2.

I Intensity Monitor This form at the bottom of the screen displays the parameters that 
must be checked prior to starting a measurement, such as 
sample’s scattering intensity strength, Auto Intensity adjustment, 
pinhole size, temperature, the appropriate cell used for 
measurement, and diluent properties within the SOP conditions 
that have been registered for the selected SOP.

The Pinhole option allows you to select one of the pinholes that will 
be used for the size or zeta potential measurements. To change 
the Pinhole from the default setting, select the desirable Pinhole 
size from the drop menu and click Setting.

The intensity of the sample appears in cps (photon counts per 
second), and the message box provides instant feedback on 
whether or not to proceed with measurement. Appropriate action 
must be taken based on the feedback.

The software adjusts the scattering intensity from the sample 
automatically. If the scattered intensity is very high, it is 
attenuated appropriately by the neutral density filters.

The Intensity Check displays the number of scattering elements 
based on their scattering intensity levels. You can select the 
minimum and divisions. The mean SD of the scattering appears at 
the end of measurement.

The ACF Check allows you to see the preview of the ACF prior to 
the size measurements.

J Status Panel The Status panel at the bottom of the window indicates connection 
status, the mode (Normal or Advanced), the permission level of the 
currently logged-in user, and the Security setting (for example, 21 
CFR Part 11).

Table 1.1  DelsaNano Main Screen Elements (Continued)

Screen Element Description
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Table 1.2  Main Menu Commands

Menu Available Commands

File Save Measured Data

Export Text

Print Preview

Print

Log Out

Exit

Display Normal Mode

Advanced Mode

Restore Default Display

Run Start

Stop

Connect

SOP Size SOP Designer

Zeta SOP Designer

Add to Measuring SOP

Remove

Favorite SOP > Add to Favorite SOP

Favorite SOP > Add to Favorite SOP Series

Favorite SOP > Organize Favorite SOP

Favorite SOP > Organize Favorite SOP Series

Option > 
21 CFR Part 11

Signature

Playback (Read File)

Playback (Real Mode)

Audit Trail Error Audit Trail

pH Calibration Audit Trail

Operation Audit Trail

Parameter Audit Trail

Help Index

Search

Printable

About
B08631AA 1-7
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Setting Security

Three security levels are available in the DelsaNano software:

 • No Security

No user ID or password is required upon software startup. No restrictions are placed on access; 
therefore, all users can use all functions.

 • Security

A user ID and password are required upon software startup. The SOPs and measurement data 
accessibility are controlled based on user level. Having a Security setting allows you to block the 
viewing of SOPs and measurement data by other users.

 • 21 CFR Part 11

A user ID and password are required upon software startup. Authorized users can use electronic 
records and electronic signatures in compliance with the FDA’s Electronic Records and 
Electronic Signatures Rule (21 CFR Part 11).

NOTE 21 CFR Part 11 security must be enabled. The Administrator can set Password Policy parameters 
for each user: password expiration, auto-logout after a period of inactivity, and auto-close of the 
Signature dialog after a period of inactivity.

Changing Security Settings

To change the security settings of the DelsaNano, you need the serial number of the instrument. The 
serial number is located on the rear panel next to the USB communication port. The serial number 
and the MAC address are used to generate the authentication code for 21 CFR Part 11.

WARNING

Do not change these numbers after you enable 21 CFR Part 11.

To change security settings:

1 Select the Security Settings icon in the Security function panel. The Security Settings dialog 
opens.
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Figure 1.4  Security Settings Dialog

2 Select the desired security setting, and click OK.

NOTE To change from No Security to Security or 21 CFR Part 11, there must be at least one user name 
registered as Administrator. If there is no Administrator, a warning message appears and the security 
setting does not change. For information on setting up user levels, see User Administration.

User Administration

The DelsaNano software supports four user levels; Table 1.3 lists their associated permissions and 
system access.

Table 1.3  User Levels and Associated Permissions

User Level Perform 
Measurements and 

Analyses?

Edit SOPs? Edit System 
Parameters?

Change User 
Information?

Operator Yes No No No

Advanced Operator Yes Yes No No

Supervisor Yes Yes Yes No

Administrator Yes Yes Yes Yes
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Viewing User Information

NOTE To access information on all system users, you must be logged in as Administrator.

To view user information:

Select the User Management icon from the Security function panel. A list of registered users 
appears.

Figure 1.5  User Management Screen

The User Management screen includes the information described in Table 1.4.

Table 1.4  User Management Screen

Screen Element Description

User Status (21 CFR Part 11 security 
must be enabled)

“Enable” appears if the user is currently enabled. “Disable” 
appears if the user is currently disabled.

Name The user name.

Level The permission level assigned to this user name. Can be one of: 
Operator, Advanced Operator, Supervisor, Administrator.

Added On The date on which the user information was created.

Public SOP When selected, the user’s SOPs can be viewed by other users.

Public Data When selected, the user’s data to be viewed by other users.
B08631AA1-10



Operation
User Administration  1
Registering New Users

NOTE To register new users, you must be logged in as Administrator.

To register a new user:

1 In the User Management window, click Add New User. The New User Profile dialog opens.

Figure 1.6  New User Profile Dialog

Password Policy (21 CFR Part 11 
security must be enabled)

The Administrator can set the following parameters for each user:

 • Password Expiration (45–300 days)
 • Automatic logout from software after a period of inactivity

(4–120 minutes)
 • Automatic Signature dialog close after a period of inactivity

(4-120 seconds)

User Management Toolbar Buttons Three buttons are available for performing user management 
functions:

 • Add New User is used to add a new user.
 • Edit User Profile is used to edit an existing user’s profile.
 • Delete User is used to delete a user. This button is replaced by 

the following when 21 CFR Part 11 is enabled:
— Disable User is used to disable a user’s login.
— Enable User is used to enable a user to log into the 

DelsaNano software.

Table 1.4  User Management Screen (Continued)

Screen Element Description
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2 Enter the user name, password, and other parameters for the new user. The parameters are 
described in Table 1.5.

3 When finished, click OK.

Table 1.5  New User Dialog

Parameter Description

Name Requires at least six alphanumeric characters.

Password Requires at least six alphanumeric characters.

Confirm Password Enter the same password again to confirm.

Level Select one of the four available user levels: Operator, Advanced Operator, 
Supervisor, Administrator.

Public SOP Select to allow other users to view and copy SOPs. Other users cannot edit the 
SOPs.

Public Data Select to allow other users to view measurement data.

Password Policy (21 CFR 
Part 11 only)

Set the following constraints:

 • Password Expiration (45-300 days)
 • Automatic logout from software after a period of inactivity (4–120 minutes)
 • Automatic Signature dialog close after a period of inactivity (4-120 seconds)
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Changing Your Password

NOTE You cannot change another user’s password. Only the Administrator can reset another user’s 
password.

To change your password:

1 Select the User Management icon in the Security function panel.

2 Click Edit User Profile. The Edit User Profile dialog opens.

Figure 1.7  Edit User Dialog

3 Select Change (next to the Password field).

4 Enter the current password in the Password field.

5 Enter a new password in the New Password and Confirm Password fields.

6 If you have Administrator privileges, you can change the settings for Public SOP, Public Data, 
and Password Policy.

7 When finished, click OK.
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Deleting Users

NOTE This feature is not available under 21 CFR Part 11 security.

To delete a user:

1 In the User Management window, select the user name to be deleted, and click Delete User. A 
confirmation dialog appears.

Figure 1.8  Delete User Dialog

2 Click OK.

Disabling or Enabling Users (21 CFR Part 11)

To disable or enable a user:

1 In the User Management window, check the user’s current status in the User Status column.

2 Select the user name to be disabled or enabled, and click Disable User or Enable User as 
appropriate. A confirmation dialog appears.

Figure 1.9  Disable User Dialog
B08631AA1-14



Operation
User Administration  1
3 Click OK.

Enabling Data Mirroring

NOTE This feature allows you to securely store files in a separate location. You must be an Administrator or 
Supervisor to enable data mirroring.

To enable data mirroring:

1 Select the Maintenance function icon panel. The System Configuration screen opens.

2 Select Data Mirroring in the System Configuration panel. The Data Mirroring screen opens.

Figure 1.10  Data Mirroring Parameters Screen

3 Select the Enable data mirroring on following location check box.

4 If you want your files to be backed up before you exit, select the Back up setting files on 
following location before exit check box.
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5 To specify the location of the backup, click Select Drive and Directory, browse to the appropriate 
location in the Browse dialog, and click OK.

Logging Out

NOTE The logout feature is not available when Security is set to “No Security.”

To log out:

1 Select File > LogOut on the Main menu bar. A confirmation dialog appears.

Figure 1.11  Logout Dialog

2 Click OK. If Security is on, the Login dialog appears.

3 To log in again, enter the user name and password, and click OK.
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Shutting Down the Software

NOTE Always shut down the software before powering off the instrument.

To shut down the DelsaNano software:

1 Select File > Exit on the Main menu bar. A confirmation dialog appears.

Figure 1.12  Quit Dialog

2 Click OK. The DelsaNano window closes.

SOP Designer

Use the SOP Designer to create new SOPs. Use the Size SOP Designer to measure particle size, and 
use the Zeta SOP Designer to measure zeta potential. In each case, you must set the following 
parameters (each set of parameters appears in its own panel in the SOP Designer screen):

 • Measurement

 • Analysis

 • Cell

 • Diluent properties

Opening the SOP Designer Window

To open the SOP Designer window, select one of the following on the SOP Designer Toolbar:

 • Click Size SOP Designer or Zeta SOP Designer.

The appropriate SOP Designer window opens.
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Figure 1.13  SOP Designer Window

Setting the SOP Designer Display Mode

The details that are displayed in the SOP Designer depend on the selected mode, Normal or 
Advanced. In Normal mode, only those parameters that must be configured to perform a 
measurement are displayed. Other parameters are hidden. In Advanced mode, all parameters are 
displayed and available for adjustment.

Table 1.6  SOP Designer Window Elements

Window Element Description

SOP Listing Displays a list of registered SOPs that have been created for each user name.

Measurement 
Parameters

Displays measurement parameters that have been created for each user name. 
Examples of parameters: file name, temperature setting, and the number of 
repetitions.

Analysis Parameters Displays analysis parameters that have been created for each user name. 
Examples of parameters: analysis algorithm and analysis results displays.

Cell Parameters Displays cell parameters for each user name. This is where you configure the cell 
used in the measurement.

Diluent Properties Displays diluent properties, such as diluent name and its refractive index, 
viscosity, and dielectric constant.
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To select the display mode, choose one of the following on the Main menu bar:

 • To use Normal mode, select Display > Normal mode.

 • To use Advanced mode, select Display > Advanced mode.

Working With SOPs

This section describes where default SOPS are located, how to export, import, create, copy, delete 
SOPs and how to edit SOP names.

Default SOPs

All default SOPs are located on the C:// (hard) drive in a subfolder labeled SOPs in the DelsaNano 
folder.

Exporting SOPs

To export an SOP:

1 Select Size SOP Designer or Zeta SOP Designer.

2 Under SOP Listing click Export SOP. Export File window opens.

3 Click Browse next to the Export File field to open the Save As dialog.

4 Select the destination, enter a file name in the Save As dialog box, and click Save.

5 In the Export File window, click Export File. A status message at the bottom of the window 
indicates the completion of the export.

6 Click Close to close the Export File window.
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Importing SOPs

To import an SOP:

1 Select Size SOP Designer or Zeta SOP Designer.

2 Under SOP Listing, click Import SOP. Import File window box opens.

3 Click Browse next to the Import File field to open and search for desired SOP.

4 Select SOP file(s) and click Open.

5 In the Import File window, click Import Selected Files... A status message at the bottom of the 
window indicates the completion of the import.

6 Click Close to close the Export File window.

Creating SOPs

To create an SOP:

1 Select the desired user name in the SOP Listing, and click New above the SOP Listing. 
Alternatively, select the user name, right-click, and select New. A new, blank SOP is created 
under the user name.

2 Enter a name for the SOP.

3 You can add the required condition in one of these ways:

 • Drag and drop the desired condition from the respective parameters panels into the SOP in 
the SOP Listing.

 • Select the desired condition, and click Add to SOP at the top of each parameter panel. Or, 
right-click on the condition name and select Add to SOP.

CAUTION

You must include the four conditions in a new SOP: Measurement, Analysis, Cell, 
Diluent.
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Copying SOPs

To copy an SOP:

Select the SOP in the SOP Listing, and click Copy above the SOP Listing. Or, select the SOP name, 
right-click, and select Copy. An exact copy of the SOP is created under the same user name. The word 
“copied” and a number are appended to the SOP name to distinguish it from the original.

Deleting SOPs

To delete a single SOP:

1 Select the SOP in the SOP Listing, and click Delete above the SOP Listing. Or, select the user 
name, right-click, and select Delete. A confirmation message appears.

Figure 1.14  Delete Selected SOP Confirmation Dialog

2 Click OK to delete the SOP.

To delete multiple SOPs:

1 Select the SOP in the SOP Listing and click Multi Delete. Multi Delete - SOP window appears.

2 Select the SOPs/Conditions to delete and click Multi Delete. A Question window appears.

3 Click OK to confirm and Close to return to the SOP Designer window.

CAUTION

Use caution when deleting an SOP. You cannot recover a deleted SOP.

Filenames are not deleted from the database. You cannot use the filename of a 
deleted SOP.
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Editing SOP Names

To edit an SOP name:

1 Select the SOP in the SOP Listing, and click Rename above the SOP Listing. Or, select the SOP 
name, right-click, and select Rename.

2 Modify the name as desired.

Editing a Condition in an SOP

When a condition type (measurement, analysis, cell, or diluent) is registered in an SOP, that 
condition cannot be modified (it is locked).

Figure 1.15  Locked Conditions

To edit a condition in an SOP:

1 Remove the condition from the SOP(s) it is registered with. Select the condition, right-click, and 
select Remove or click Remove in the SOP Listing. A confirmation message appears. 
Alternatively, you can make a copy of the condition and edit it in the corresponding panel 
(Measurement, Analysis, Cell, and Diluent).

Figure 1.16  Remove Condition Confirmation Dialog

2 Click OK.
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3 Edit the condition as necessary.

Figure 1.17  Editing a Condition

SOPs for Particle Size Measurements: Measurement Parameters

Figure 1.18 shows the measurement parameters that are set in SOPs for Particle Size Measurements. 
Parameters in italics are available in Advanced mode only.
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Figure 1.18  SOPs for Particle Size Measurements: Measurement Parameters

Table 1.7  SOPs for Particle Size Measurements: Measurement Parameters

Parameter 
Group

Parameter Description

General Condition Name This is a name for identifying the measurement condition. Provide a 
unique, easily understood name that is different from other condition 
names. You can enter up to 20 characters.

File Name Enter a file name for storing the measured data. You can enter up to 40 
characters.

Group This is used to create a group in which files can be stored for easy access 
and searching. In the analysis, the data lists can be sequenced by group. 
Enter a group name up to 40 characters.
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Sample Information This is used for describing sample information and the measurement 
parameters. You can enter up to 20 characters.

File Save Select Auto to save the data automatically or Manual to save the data 
manually after the measurements are completed.

Repetition Enter the number of times that the analysis is to be repeated. The 
maximum value allowed is 10,000.

Auto Print To print the results automatically after the size measurement is 
completed, click the button next to “Auto.” This opens a Print dialog, 
where you select the items you want to print. For more information, see 
Printing Particle Size Analysis Data. If you do not want the results printed 
automatically, leave the options in the Print dialog blank.

Manual Temperature Setting This is used to select the measurement temperature. Select Yes, and 
enter the desired temperature in the Temperature (°C) field, which 
appears automatically. The temperature range allowed is 5–90°C.

If you select No, the measurement is performed at the temperature 
currently set in the Intensity Monitor.

CAUTION

Select No to measure at the same temperature as the current 
temperature setting. If you select Yes, the temperature setting is 
performed again at the beginning of the measurement, even if the 
temperature setting is the same as the current temperature, and 
some time elapses before temperature stabilization.

NOTE For a temperature setting under 10°C, using     Nitrogen air is 
recommended to prevent condensation on the cell surface.

Equilibrating If you select Yes, the measurement is not started until the set 
temperature is reached. Select Yes when measuring at the temperature 
selected in the “Manual Temperature Setting” field.

Statistical Summary Select Yes to save the measurement data in a statistical summary table, 
then enter the file name in the Statistical File Name field, which appears 
automatically. You can enter up to 20 characters.

You can access the statistical summary table by the selecting the QC icon 
in the Size Analysis panel.

Intensity Adjustment Select Yes to enable the auto intensity adjustment prior to the size 
measurement.

Equilibration (sec) Enter the delay time (in seconds, up to a maximum of 100,000) that will 
elapse prior to starting a measurement. The equilibration time will start 
when the run begins, and measurement will start when the equilibration 
time has elapsed.

Wait Time (sec) Enter the wait time (in seconds) between repeated measurements. Enter 
a value between 0–100,000.

Table 1.7  SOPs for Particle Size Measurements: Measurement Parameters (Continued)

Parameter 
Group

Parameter Description
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Size 
Measurement 
(Details)

Dust Limit This is the amount of time prior to the actual measurement to calculate 
the average intensity produced by the presence of dust. Enter a value 
between 0–10. No dust limit will be set if this value is “0.”

Upper Dust Limit % This is the threshold of the upper limit to be used during the analysis. 
Enter a value between 0–100. Any data that has an intensity above the 
upper threshold limit will be ignored. The default value is 10%.

Lower Dust Limit % This is the lower dust limit. As with the upper limit, this sets the difference 
from the average value. Enter a value between 0–100. The default value 
is 100%, which means this accepts the data lower than average strength 
as valid data.

Minimum Intensity (cps) Enter the minimum intensity allowed in the automatic intensity 
adjustment. Enter a value between 0–300,000.

Optimum Intensity (cps) Enter the optimum intensity allowed in the automatic intensity 
adjustment. Enter a value between 0–300,000.

Maximum Intensity (cps) Enter the maximum intensity allowed in the automatic intensity 
adjustment. Enter a value between 0–300,000.

Pinhole (m) This sets the pinhole size. The default value is 50 m, which normally is 
used without modification. The sizes that can be set for the pinhole are 
20, 50, and 100 m. If it is not possible to obtain an adequate intensity 
because the sample is small and the concentration is low, set the pinhole 
to 100 m. If the intensity is too high at the lowest aperture (ND filter), 
set to 20 m.

CAUTION

If the pinhole setting is large, the intensity (scattering strength) 
that can be obtained is increased; however, the state of the 
coherence will be worse, reducing the signal-to-noise ratio.

Table 1.7  SOPs for Particle Size Measurements: Measurement Parameters (Continued)

Parameter 
Group

Parameter Description
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SOPs for Particle Size Measurements: Analysis Parameters

Figure 1.19 shows the analysis parameters that are set in SOPs for Particle Size Measurements. 
Parameters in italics are available in Advanced mode only.

Figure 1.19  SOPs for Particle Size Measurements: Analysis Parameters
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Table 1.8  SOPs for Particle Size Measurements: Analysis Parameters

Parameter 
Group

Parameter Description

General Condition Name This is a name that identifies the analysis condition. 
Provide a unique, easily understood name that is different 
from other condition names. You can enter up to 20 
characters.

Comment You can enter a comment about the analysis parameters. 
Enter up to 20 characters.

Analysis Method Select the algorithm that will be used in the particle size 
distribution analysis. There are three different analysis 
algorithms: CONTIN, Marquardt, NNLS. For information on 
these analysis algorithms, see the Introduction.

Left Threshold Enter the specific number of channels to be removed on 
the left side of particle size distribution. Up to 45 channels 
can be removed. This is useful for removing unwanted 
distribution due to noise.

Right Threshold Enter the specific number of channels to be removed on 
the right side of particle size distribution. Up to 45 
channels can be removed. This is useful for removing 
unwanted distribution due to clumps/agglomerates.

Display ACF Select Yes to display a second-order autocorrelation 
function plot.

Realtime Size Monitor Select Yes to display a plot of the particle size values in 
each integration cycle (accumulation times) during a 
measurement. This makes it possible to confirm the 
stability of the sample, such as whether or not the particle 
size changes over time during the measurement. For more 
information and an example of a Realtime Size Monitor 
display, see APPENDIX D, Graphs and Table Displays.

Realtime Size Table Select Yes to display a table of the particle size values in 
each integration cycle (accumulation times) during a 
measurement. For more information and an example of a 
Realtime Size Table display, see APPENDIX D, Graphs and 
Table Displays.

Intensity Distribution Select Yes to display the particle size distribution (the 
intensity distribution) showing both differential and 
cumulative. For more information and an example of an 
Intensity Distribution display, see APPENDIX D, Graphs 
and Table Displays.

Volume Distribution Select Yes to display the particle size distribution (the 
volumetric conversion distribution) showing both 
differential and cumulative. For more information and an 
example of a Volume Distribution display, see 
APPENDIX D, Graphs and Table Displays.
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Number Distribution Select Yes to display the particle size distribution (the 
numeric conversion distribution) showing both differential 
and cumulative. For more information and an example of 
a Number Distribution display, see APPENDIX D, Graphs 
and Table Displays.

Ln (G2()-1) vs  Plot Select Yes to display a second-order autocorrelation 
function logarithmic plot.

Size Dist. Table Select Yes to display the particle size frequency 
distribution table.

Cumulative Size Dist. Table Select Yes to display the particle size distribution 
cumulative frequency table.

ACF Listing Select Yes to display a second-order autocorrelation 
function table.

Condition Summary Select Yes to display extracts of the measurement 
parameters, analysis parameters, cell parameters, and 
diluent properties, including the SOP name and file name.

Graph X-Axis This is used to switch the particle size distribution graph 
X axis (particle size range) between the automatic and 
manual settings or a pre-selected size range (0.1-1000 nm 
or 1-10,000 nm). For manual settings, the upper limit (X) 
and lower limit (X) will be displayed. Input the range, which 
can be between 0.1–10,000 nm. This is useful if you want 
to see a size distribution within a specified range.

Upper Limit (X) Enter the maximum value for the particle size distribution 
graph X axis (particle size range). This parameter is visible 
when Graph X-Axis is set to a fixed scale (10,000 nm).

Lower Limit (X) Enter the minimum value for the particle size distribution 
graph X axis (particle size range). This parameter is visible 
when Graph X-Axis is set to a fixed scale (0.1 nm).

Graph Y-Axis This is used to switch the particle size distribution graph 
Y axis (frequency) between the automatic and manual 
settings. For manual settings, the upper limit (Y) will be 
displayed. Enter the range (1–100).

Upper Limit (Y) Enter the maximum value for the particle size distribution 
graph Y axis (frequency). This parameter is visible when 
Graph Y-Axis is set to a fixed scale.

Others Fitting Range Select the axis fitting range of G2(), or select the range of 
. Then, enter the corresponding maximum and minimum 
values in the two fields below this one.

G2() max For fitting range G2(), enter the upper limit to be used for 
calculating the size distribution. The maximum value 
allowed is 2.

Table 1.8  SOPs for Particle Size Measurements: Analysis Parameters (Continued)

Parameter 
Group

Parameter Description
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G2() min For fitting range G2(), enter the lower limit to be used for 
calculating the size distribution. The minimum value 
allowed is 1.

 max For fitting range , enter the maximum value to be used in 
fitting (maximum 983040 μs).

 min For fitting range , enter the minimum value to be used in 
fitting (minimum 0.1 μs).

Noise Threshold (%) Set the lower limit value on the frequency (0–100%) of the 
peak displayed in the graph in the particle size distribution 
graph. A peak that is lower than this lower limit value is 
handled as noise, and is not displayed on the particle size 
distribution graph. The default value is 0.3%.

Molecular 
Weight Analysis 
Constants

Molecular Weight 
Calculation

This is used to determine the molecular weight of the 
sample. If you select Yes, you are prompted to enter the a 
and b constants pertaining to the sample.

For more information, see APPENDIX C, Alpha and Beta 
Values.

 Enter the a value of the sample ranging from 1E-09 to less 
than 0.1.

 Enter the b value of the sample ranging from 0.3 to 1.

Table 1.8  SOPs for Particle Size Measurements: Analysis Parameters (Continued)

Parameter 
Group

Parameter Description
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SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell 
Parameters

In the cell parameters, the parameters that are displayed differ depending on the measurement 
items and the measurement types. There are several measurement types available for each cell (see 
Figure 1.20). Each measurement type includes specific routines and/or tests to perform during a 
measurement.

Figure 1.20  Measurement Types

The parameters that are displayed for each measurement item (particle size and zeta potential) are 
shown below. Additionally, the types of parameters that are displayed will differ depending on the 
measurement type, even given the same measurement item, so a numeric value indicating the item 
that appears in the measurement type is noted after the parameter name.

Figure 1.21 shows the cell parameters that are set in SOPs for Particle Size and Zeta Potential 
Measurements. Parameters in italics are available in Advanced mode only.
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Figure 1.21  SOPs for Particle Size and Zeta Potential Measurements: Cell Parameters

Table 1.9  SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell Parameters

Parameter 
Group

Parameter Description

Parameters for both Measurement Items (Particle Size and Zeta Potential)

General Condition Name This name identifies the cell condition. Provide an easily 
understood name up to 20 characters that can 
differentiate from other cell condition.

Comment You can enter a comment about the cell parameters. Enter 
up to 20 characters.

Measurement Item Select Particle Size or Zeta Potential for the measurement 
item.
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Cell Name Select, from the dialog, the cell that is to be used. The 
registration of cells is performed in the Maintenance 
section of the software.

CAUTION

Before using the High Concentration cell, make sure 
the sample conductivity is lower than ~3 mS/cm.

Cell Type This displays the type of cell that will be used.

Cell Center X (mm) This shows the optimal position of the cell on the X axis. 
The value will be the default X value for that cell, unless a 
cell center adjustment has been performed and saved. 
The saved cell center adjustment will be displayed here. 
See Detecting the Optimal Cell Position.

This disappears when either Type 2 or Type 4 is selected.

Cell Center Z (mm) This shows the optimal position of the cell on the z axis. 
The value will be the default Z value for that cell, unless a 
cell center adjustment has been performed and saved. 
The saved cell center adjustment will be displayed here. 
See Detecting the Optimal Cell Position.

This disappears when either Type 2 or Type 4 is selected.

Parameters if the Measurement Item is “Size”

General Measurement Type Type 1: Measures only the particle size.

Type 2: Starts the measurement after automatic detection 
of the optimal cell position at the time of measurement. 
The optimal position for the cell can also be detected in 
advance. For details, see Detecting the Optimal Cell 
Position.

Type 3: Performs the particle size measurement after 
using the titrator to adjust the pH and other parameters.

Type 4: Performs the particle size measurement after 
using the titrator to adjust the pH and other parameters 
and performing automatic detection of the optimal cell 
position.

CAUTION

Type 3 and Type 4 are available only when the Auto 
Titrator is configured on the system.

Table 1.9  SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell Parameters

Parameter 
Group

Parameter Description
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Details Correlator Type Log correlator is the default correlator. Log correlator 
covers a wide range of decay times and can be used to 
measure any sample having broad distribution.

Linear correlator has high resolution within the limited 
range of decay time and thus it is suitable for very small 
particles of narrow distribution. You can use Linear 
correlator if you have prior knowledge of the sample.

Size 
Measurement

Accumulation Times Enter the number of integration cycles for the 
measurement. The default value is 70. At this value, the 
software determines 70 ACFs and calculates 70 realtime 
diameters from each ACF and finally calculates one 
averaged ACF from 70 ACFs to give the mean diameter.

Increase the number of cycles if the intensity of the 
sample is weak or if the signal is too noisy to obtain a 
stable autocorrelation function. If the intensity is less than 
10,000 cps, use the following formula as a guideline to 
input the number of integrating cycles.

Number of integration cycles = 10,000 (cps)/intensity of 
the sample (cps)  10.

Size 
Measurement 
(Details)

Correlation Method Select either Time Domain (TD), Time Interval (TI), or Auto. 
This parameter is valid only when the Linear correlator is 
selected. Generally, you select TD for large particles 
having stronger scattering levels, and you select TI for 
small particles of less than 10 nm having weaker 
scattering levels.

If you are not sure what to use, select Auto.

Sampling Time (s) Select the sampling time from the list. This parameter is 
valid only when the Linear correlator is selected. If you 
don’t know what to use, select Auto.

The sampling time is the time after which the signal is 
collected from the sample by the instrument. Appropriate 
sampling time must be selected to get a smoother ACF 
and for accurate size measurement.

Correlation Channel Select the correlation channel of the correlation 
calculation from the list. This parameter is valid only when 
the Linear correlator is selected. If you don’t know what to 
use, select Auto.

The correlation channel represents the number of bins into 
which the size data is distributed. It is the size resolution 
(the more channels, the more divisions on the size scale, 
i.e., X-Axis.

Table 1.9  SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell Parameters

Parameter 
Group

Parameter Description
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Titrator Titration Mode (3 & 4) Select this parameter to carry out the pH titration vs. size, 
diluting/priming, or circulation of the sample.

NOTE Titration Mode is applicable only when you are   
using a flow cell or Size cell (Flow).

pH Titration pH Table (3 & 4) This parameter is valid when pH titration is selected as the 
operating mode of the Auto Titrator. The Auto Titrator can 
titrate from pH 1–13. The pH values can be entered from 
low to high or from high to low. Set the pH value to be 
adjusted.

pH Tolerance (3 & 4) This parameter is valid when pH titration is selected as the 
operating mode of the Auto Titrator. Set the tolerance 
value for the pH adjustment. The pH value is considered to 
have been completed if the pH is in the range (the pH 
setting ± the tolerance value). It ranges from 0.05–2.

Pipetting Titration Volume Table
(3 & 4)

This parameter is valid when Pipetting is selected as the 
operating mode of the Auto Titrator. This sets the volume 
of the additive to be added. The additive volume range is 
1–50,000 ml.

Circulation Time (min)
(3 & 4)

This parameter is valid when Pipetting is selected as the 
operating mode of the Auto Titrator. This sets the time for 
the sample to circulate around the flow cell after adding 
additive. The circulation time range is 1–999 minutes.

Circulation Circulation Time Table
(3 & 4)

This parameter is valid when circulation is selected as the 
operating mode of the Auto Titrator. This sets the time for 
the sample to circulate around the flow cell. The circulation 
time range is 1–999 minutes.

Parameters if the Measurement Item is “Zeta Potential”

General Measurement Type Type 1: Base+Measurement: Performs base measurement 
first, then actual zeta potential measurement. Base refers 
to the modulator frequency that acts as a reference. The 
base measurement is required before measuring zeta 
potential. The base frequency is dependent on the type of 
cell used and the concentration of the sample. The base 
frequency for Flow cell, Flat Surface cell, Disposable Zeta 
cell, and Low Conductivity cell ranges from 110–140 Hz 
and from 220–270 Hz for High Concentration cell. It can be 
affected by other electrical devices near the DelsaNano. 
For more information and an example of an ACF (Base) 
graph, see ACF (Base). 

Type 2: Center Detection+Base+Measurement: Performs 
center detection, base measurement, and sample zeta 
potential measurement. 

Table 1.9  SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell Parameters

Parameter 
Group

Parameter Description
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Type 3: Titrator+Base+Measurement: Performs either pH 
titration, pipetting or circulation, then base measurement 
and sample zeta potential measurement.

Type 4: Titrator+Center Detection+Base+Measurement: 
Performs either pH titration, pipetting or circulation, then 
center detection, base measurement and sample zeta 
potential measurement.

CAUTION

Type 3 and Type 4 are available only when the Auto 
Titrator is configured on the system

Cell Constant Displays the cell constant, determined by using an 
electrical conductivity standard solution. See Measuring 
the Cell Constant for the method of determining the cell 
constant. Upon cell selection, the default cell constant 
appears. The cell constant must be measured when the 
cell is replaced, or when the electrodes are replaced.

Detail Correlator Type This is used to select the correlator for zeta potential 
measurement. The default correlator is Linear.

Zeta 
Measurement

Accumulation Times This is the number of times the instrument measures the 
zeta potential at a particular position. The default value is 
10 for flow cell and Flat Surface cell, and 20 for High 
Concentration cell; however, it can be changed.

Cell Position This sets the position of the cell when the measurement is 
performed. The setting will vary, depending on the cell 
that is used, and it can be changed. The typical settings 
are:

Flow cell and Disposable Zeta cell: 5 points: 
0.7/0.3/0/-0.35/-0.7

High Concentration cell and Low Conductivity cell: 1 
point: 0

Flat Surface cell: 7 points: 0.8/0.6/0.3/0/-0.3/-0.6/-0.8

During the measurement, the instrument measures zeta 
potential up to five different locations to eliminate the 
effects of Brownian motion. The number of positions can 
vary from -1 to +1. The points can be in ascending or 
descending order.

Zeta 
Measurement 
Detail

Applied Voltage Select how you want the applied voltage to be set, 
automatically or manually. If you don’t know what to use, 
select Auto. When you select Fixed, you are prompted to 
enter the DC voltage.

Applied Voltage (Fixed) This is used for inputting the voltage value if the applied 
voltage is to be set manually. The DC voltage range is 0–
300 V.

Table 1.9  SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell Parameters

Parameter 
Group

Parameter Description
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Polarity This is used to select the polarity of the applied voltage 
from positive, negative, or automatic on the reference 
electrode. If you don’t know what to use, select Auto.

Maximum Current (mA) This allows you to set the maximum amount of current 
that flows through the sample cell during measurement.

Titrator Titration Mode (3 & 4) This is selected to carry out the pH titration vs. size, 
diluting/priming, or circulation of the sample. This applies 
only if the cell type is flow cell.

pH Titration pH Table (3 & 4) This parameter is valid when pH titration is selected as the 
operating mode of the Auto Titrator. The Auto Titrator can 
titrate from pH 1–13. You can enter the pH values from low 
to high or from high to low. Set the pH value to be adjusted.

pH Tolerance (3 & 4) This parameter is valid when pH titration is selected as the 
operating mode of the Auto Titrator. Set the tolerance 
value for the pH adjustment. The pH value is considered to 
have been completed if the pH is in the range (the pH 
setting ± the tolerance value). It ranges from 0.05–2.

Circulation Time (min)
(3 & 4)

This is used to set the time for the pH adjustment. The 
adjustment is considered to have been completed if this 
set time has elapsed, even if the pH value is not within the 
range of the tolerance value. Moreover, the sample is 
circulated until the set time has elapsed, without 
advancing to the next operation, even if the pH value is 
within the tolerance range when within this time.

Additive 
Titration

Titration Volume Table
(3 & 4)

This parameter is valid when additive titration is selected 
as the operating mode of the Auto Titrator. This sets the 
volume of the additive to be titrated.

Circulation Time 
(3 & 4)

This parameter is valid when additive titration is selected 
as the operating mode of the Auto Titrator. This sets the 
sample circulation time at the time of additive titration.

Circulation Circulation Time Table 
(3 & 4)

This parameter is valid when circulation is selected as the 
operating mode of the Auto Titrator. This sets the 
circulation time.

Table 1.9  SOPs for Particle Size Measurements and Zeta Potential Measurements: Cell Parameters

Parameter 
Group

Parameter Description
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SOPs for Particle Size Measurements and Zeta Potential Measurements: Diluent 
Properties

Table 1.10 describes the parameters that are set in the Diluent Properties section of the SOP 
Designer windows. Parameters in italics are available in Advanced mode only.

Adding a Diluent to the Diluent List

If the diluent property you want is not in the diluent list, you can add a new diluent by following the 
steps in this procedure.

To add a new diluent to the diluent list:

1 In the Diluent Properties panel of the Size SOP Designer or Zeta SOP Designer, click Diluent List. 
The Select Diluent List dialog appears.

2 In the Select Diluent List dialog, select New on the menu bar, and enter the diluent name in the 
Diluent Name field.

3 Optionally, enter a comment in the Comment field (To return to the diluent list without adding 
a new diluent, click Return to List).

Table 1.10  SOPs for Particle Size Measurements and Zeta Potential Measurements: Diluent Properties

Parameter 
Group

Parameter Description

General Condition Name This is a name for identifying the diluent. The diluent name 
can be used as the condition name. Provide a unique, 
easily understood name up to 20 characters that is 
different from other condition names.

Comment You can enter a comment about the diluent. Enter up to 20 
characters.

Diluent Name Select the diluent name from the drop-down menu.

Properties Refractive Index This displays the Refractive Index of the selected diluent.

Viscosity This displays the viscosity of the selected diluent.

Dielectric Constant This displays the Dielectric Constant of the selected 
diluent.
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4 To add the Refractive Index, Viscosity, and Dielectric Constant of the diluent to the list, as 
follows.

 • In Case 1 (Figure 1.22):

If the parameters of the diluent are known only at a certain temperature (for example, 
30 C), input the temperature as 30 C and the corresponding Refractive Index, Viscosity, 
and Dielectric Constant values of the diluent. Select Manual [Fixed] next to each parameter, 
and select Add to List on the menu bar. Click OK to close the dialog.

Figure 1.22  Adding a Diluent, Case 1

 • In Case 2 (Figure 1.23):

If the parameters of the diluent are known at a different temperature, a table can be built 
(such that the software can use any of these parameters for the temperatures at which the 
parameters are not directly available) from the fitting curves to determine the particle size 
or zeta potential.

To create the table using Refractive Index as an example, input the Refractive Indices of the 
diluent for the known temperatures (for example, 15 C, 20 C, and 30 C).

To obtain the Refractive Index of the diluent at a different temperature (for example, 25 C, 
which is not listed in the table), input the temperature as 25 C in the Temperature column, 
and select Auto next to the parameter. Use one of the Calculated Coefficients that best fits 
the Refractive Index, and click Add to Diluent Parameter List. Select Add to List on the menu 
bar, and click OK to close the dialog.
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Figure 1.23  Adding a Diluent, Case 2

NOTE The software automatically picks the values of the Diluent Refractive Index, Viscosity, and 
Dielectric Constant from the table for the temperature at which these values are not available, 
provided the table is built for that diluent.

Calculating the Diluent Properties of a Mixture

To calculate the diluent properties of a mixture:

1 In the Diluent Properties panel of the Size SOP Designer or Zeta SOP Designer, click Diluent List. 
The Select Diluent List dialog appears.

2 In the Select Diluent List dialog, select New (Mixture) on the menu bar, and enter the diluent 
name in the Diluent Name field.

3 Select Diluent 1 (Water or others). If “others” is selected, highlight the diluent in Diluent 1 table. 
Similarly highlight the diluent in Diluent 2 table.

4 Enter Diluent 2 Contents (wt% or mM) and Temperature (C).

5 Click Calculation.
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Deleting a Diluent

To delete a diluent:

1 In the Diluent Properties panel of the Size SOP Designer or Zeta SOP Designer, click Diluent List. 
The Select Diluent List dialog appears.

2 Select the name of the diluent you want to delete from the diluent list.

3 Select Delete on the menu bar.

CAUTION

You cannot recover a diluent that has been deleted. Default diluents cannot be 
deleted.

SOPs for Zeta Potential Measurements: Measurement Parameters

Figure 1.24 shows the measurement parameters that are set in SOPs for Zeta Potential 
Measurements. Parameters in italics are available in Advanced mode only.

Figure 1.24  SOPs for Zeta Potential Measurements: Measurement Parameters
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Table 1.11  SOPs for Zeta Potential Measurements: Measurement Parameters

Parameter 
Group

Parameter Description

General Condition Name This is a name for identifying the measurement condition. 
Provide a unique, easily understood name up to 20 
characters that is different from other condition names.

File Name This is the file name for storing the measured data. Enter 
a file name up to 40 characters. Spaces are not allowed.

Group This is used to identify samples. In the analysis, the data 
lists can be sequenced by group. Enter a group name up 
to 20 characters.

Sample Information This is used to describe sample information and the 
measurement parameters. Enter a description up to 40 
characters.

File Save Select Auto to save the data automatically or Manual to 
save the data manually after the measurements are 
completed.

Manual Temperature Setting This is used to select the measurement temperature. 
Select Yes, and enter the desired temperature in the 
Temperature (° C) field, which appears automatically. The 
temperature range allowed is 5–90° C.

If you select No, the measurement is performed at the 
temperature currently set in the Intensity Monitor.

CAUTION

Select No to measure at the same temperature as 
the current temperature setting. If you select Yes, 
the temperature setting is performed again at the 
beginning of the measurement, even if the 
temperature setting is the same as the current 
temperature, and some time will elapse before 
temperature stabilization.

Equilibrating If you select Yes, the measurement will not be started until 
the set temperature is reached. Select Yes when 
measuring at the measurement temperature in the 
“Manual Temperature Setting” field.

Statistical Summary Select Yes to save the measurement data in a statistical 
summary table, then enter the name of the file you want 
in the Statistical File Name field, which appears 
automatically. You can enter up to 20 characters.

Statistical File Name Enter the name of the statistical file. If an identical 
statistical file name exists, the data is appended to the end 
of that file.
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Zeta 
Measurement

Repetition This is the number of times that the measurement is 
repeated. The maximum value allowed is 10,000.

Auto Print If you want the results printed automatically after the 
measurement is completed, click the button next to 
“Auto.” This opens the Print dialog, where you select the 
items you want to print. For more information, see Printing 
Zeta Potential Analysis Results. If you do not want the 
results printed automatically, leave the options in the Print 
dialog blank.

Equilibration (sec) Enter the delay time (in seconds, up to a maximum of 
100,000) that elapses prior to starting a measurement. 
The equilibration time starts when the run begins, and 
measurement will start when the equilibration time has 
elapsed.

Wait Time (sec) Enter the wait time (in seconds, up to a maximum of 
10,000) between repeated measurements.

Pinhole (m) This sets the pinhole size. The default value is 50 m, 
which normally is used without modification. The sizes 
that can be set for the pinhole are 20, 50, and 100 m. If 
it is not possible to obtain an adequate intensity because 
the sample is small and the concentration is low, set the 
pinhole to 100 m. If the intensity is too high at the lowest 
aperture (ND filter), set to 20 m.

CAUTION

If the pinhole setting is large, the intensity 
(scattering strength) that can be obtained is 
increased; however, the state of the coherence will 
be worse, reducing the signal-to-noise ratio.

Table 1.11  SOPs for Zeta Potential Measurements: Measurement Parameters (Continued)

Parameter 
Group

Parameter Description
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SOPs for Zeta Potential Measurements: Analysis Parameters

Figure 1.25 shows the analysis parameters that are set in SOPs for Zeta Potential Measurements. 
Parameters in italics are available in Advanced mode only. 

Figure 1.25  SOPs for Zeta Potential Measurements: Analysis Parameters

Table 1.12  SOPs for Zeta Potential Measurements: Analysis Parameters

Parameter 
Group

Parameter Description

General Condition Name This is a name for identifying the analysis condition. 
Provide a unique, easily understood name up to 20 
characters that is different from other condition names.

Comment You can enter a comment about the analysis parameters. 
Enter up to 20 characters.

Lorentzian Fit This is used to set the number of peaks when making a 
Lorentzian fit with the zeta potential distribution.

In the distribution graph, the Brownian motion of the 
particles is characterized by a Lorentzian peak centered at 
a frequency shift that characterizes Electrophoretic 
mobility of the particles.

If the sample is a mixture of particles of different mobility, 
e.g., 2, then 2 peaks can be selected for the Lorentzian Fit.

The default selection is 1 peak that corresponds to the 
fitted data. When None is selected, the distribution graph 
displays the raw data; i.e., intensity zeta potential/mobility 
distribution.
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Conversion Equation This is used to select the equation for calculating the zeta 
potential from the mobility. You may select Smoluchowski, 
Huckel, or Other. Generally, Smoluchowski is used for 
aqueous samples and Huckel is used for organic samples. 
A coefficient must be input when you select Other. This 
coefficient is substituted for the “k” in the following 
equation:

: Zeta potential, : Viscosity of the solution, 
: Dielectric constant of the solution, U: Mobility

Display ACF Select Yes to display a second-order autocorrelation 
function plot.

For more information, see the Introduction.

Distribution Graph Select Yes to display a graph of the zeta potential 
measurement results. It is possible to select whether the 
display will display using the zeta potential or using the 
mobility. For more information and an example of a 
Distribution Graph, see APPENDIX D, Graphs and Table 
Displays.

3D Graph Select Yes to display the profile for the velocity of 
movement of the particles, including the electrosmosis. 
The 3D Graph can be viewed for mobility of the particles. 
For more information and an example of a 3D Graph, see 
APPENDIX D, Graphs and Table Displays.

Peak Value Table Select Yes to display a table of the apparent mobility and 
zeta potential results. For more information and an 
example of a Peak Value Table, see APPENDIX D, Graphs 
and Table Displays.

Condition Summary Select Yes to display extracts of the measurement 
parameters, analysis parameters, cell parameters, and 
diluent properties, including the SOP name and file name.

Table 1.12  SOPs for Zeta Potential Measurements: Analysis Parameters (Continued)

Parameter 
Group

Parameter Description
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Other Functions of the SOP Designer

This section describes how to detect the optimal cell position, how to measure the cell constant, and 
how to measure the electrical conductivity.

Detecting the Optimal Cell Position

The measurement cell can be positioned to obtain an optimum intensity for measurement. This 
value is saved in the cell parameter.

Perform Cell Center adjustment under the following conditions:

 • when a new cell parameter is created
 • the first time a cell is used in a measurement
 • if the concentration or sample type changes

You can repeat the Cell Center adjustment if the intensity monitor shows the sample concentration 
is too low.

To detect the optimal cell position:

1 In the Cell Parameters, click Adjust Cell Center. The Cell Center Detection dialog opens.

Figure 1.26  Cell Center Detection Dialog
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2 Click Start. The optimal position for measurement is detected automatically, depending on the 
selected cell type. After the detection has been completed, the results appear in the Result pane.

3 Click OK to store the calculated cell position in the cell parameters. If you click Cancel, the 
previous center (the cell position from the previous time) remains stored as is, and the cell 
moves to the previous location.

You can see the following:

 • The variation of intensity of the cell position
 • The attenuator percentage
 • The previous and new cell centers

Measuring the Cell Constant

When you click Cell Const. Meas. in the cell parameters, the Cell Constant Measurement screen 
opens. The number of measurement cycles is set by Rept. Times, and the conductivity standard used 
can be selected on the right-hand side of the display under Conductivity. When measuring the cell 
constant using a solution other than the 10 mM or 100 mM NaCl solution, place a checkmark next 
to Other and input the conductivity of the solution used.

The cell constant measurement begins when you click Start (to stop the measurement, click Stop). 
When the measurement has been completed, the cell constant appears as the Current Cell Constant, 
and the previous cell constant is also displayed. The cell constant is saved in the cell parameters 
when you click OK. If canceled, the cell constant is not saved, and the previous cell constant remains 
as-is.

Perform a cell constant when you create a new cell parameter, when a cell is used for the first time, 
or when the electrodes have been replaced.

Figure 1.27  Cell Constant Measurement Screen
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Measuring the Electrical Conductivity

The following dialog opens when you click Conductivity Check in the cell parameters. Click Start to 
start the measurement (to stop it, click Stop), and the measurement results for the conductivity of 
the sample will be displayed. To cancel the operation prior to completion, click Cancel.

Perform the conductivity check when the concentration of your sample changes or the sample type 
is unknown.

Figure 1.28  Conductivity Measurement Dialog

Saving to Favorite SOPs

You can save regularly-used SOP as a “Favorite SOP” or “Favorite SOP Series.”

Saving an SOP to Your Favorite SOP List

To save an SOP to your Favorite SOP list:

Select the SOP from either Measuring SOP, Particle SOP listing, or Zeta SOP listing, and select SOP > 
Favorite SOP > Add to Favorite SOP on the Main menu bar.
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Figure 1.29  Favorite SOP List Example

Saving an SOP to Your Favorite SOP Series

To save an SOP to your Favorite SOP Series:

1 Select the SOP from either Measuring SOP, Particle SOP listing, or Zeta SOP listing, and select 
SOP > Favorite SOP > Add to Favorite SOP Series on the Main menu bar.

SOP Series Name window opens.

2 Enter an SOP Series Name and Click OK.
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Calling a Favorite SOP

If multiple SOPs are generated and saved, the SOP can be read out at the time of the next 
measurement and saved as a Selected SOP.

To call an SOP from your Favorite SOP list:

1 Select SOP > Favorite SOP > Organize Favorite SOP on the Main menu bar. Organize Favorite SOP 
dialog box appears.

2 Select an SOP, and click Add to Measuring SOP to store that SOP as a Selected SOP.

Calling and Deleting a Favorite SOP Series

To call or delete an SOP from your Favorite SOP Series:

1 Select SOP > Favorite SOP > Organize Favorite SOP Series on the Main menu bar.

Organize Favorite SOP Series dialog box appears.
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2 Select an SOP Series, and click Add to Measuring SOP to store the Selected SOP Series or click 
Delete SOP Series to delete the Selected SOP Series.

3 Click Close to close the Organize Favorite SOP Series window.

 Exporting Favorite SOP Series Files

You can export SOP files from your Favorite SOP Series to a folder or external memory.

To export SOP files from your Favorite SOP Series:

1 Select SOP > Favorite SOP > Organize Favorite SOP Series on the Main menu bar.

Organize Favorite SOP Series window appears.

2 Click Export SOP Series. The Export SOP Series window opens.
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3 Click Browse next to the Export File field to open the Save As dialog.

4 Select the destination, enter a file name in the Save As dialog, and click Save.

5 In the Export SOP Series window, click Export File. A status message at the bottom of the window 
indicates the completion of the export.

6 Click Close to close the Export SOP Series window.

7 Click Close to close the Organize Favorite SOP Series window.
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Importing Favorite SOP Series Files

Use the Import function to include exported SOP Series data in a data file list.

You can export SOP files from your Favorite SOP Series to a folder or external memory.

To import SOP files from your Favorite SOP Series:

1 Select SOP > Favorite SOP > Organize Favorite SOP Series on the Main menu bar.

Organize Favorite SOP Series window appears.

2 Click Import SOP Series. The Import SOP Series window opens.

3 Click Browse next to the Import File field to open the Open dialog.

4 Select a file name in the Open dialog, and click Open.
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5 In the Import SOP Series window, click Import File. A status message at the bottom of the 
window indicates the completion of the export.

6 Click Close to close the Import SOP Series window.

7 Click Close to close the Organize Favorite SOP Series window.
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Measuring Particle Size and Zeta Potential

This section describes how to prepare for the measurement, how to start and stop the 
measurement, and how to display and print measurement results.

Figure 1.30 shows the first screen that appears when you start the software (and log in if necessary).

Figure 1.30  Data Acquisition Measurement Screen

Table 1.13  Data Acquisition Measurement Screen Elements

Screen Element Description

Data Acquisition function 
icons

Displays the selected icon; in this case, Measurement.

Selected Measuring SOP 
Listing

Displays the SOP that will be used in the measurement.

Particle Size SOP Listing Displays the particle size measurement SOPs that have been registered.

Zeta Potential SOP Listing Displays the zeta potential SOPs that have been registered.
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Selecting the Measurement SOP

To select the measurement SOP:

1 In the Measurement screen, select the desired SOP from the SOP listing.

2 Select SOP > Add to Measuring SOP on the Main menu bar, or click Add to Measuring SOP. (You 
can also drag and drop the SOP into the Measuring SOP.) This registers the selected SOP.

NOTE Up to a maximum of 20 SOPs can be registered to the Selected SOPs. When multiple SOPs are 
registered, execution will proceed from the top of the list.

CAUTION

When multiple SOPs are registered, the registered SOPs must all use the same 
type of cell and diluent.

SOP Preview Displays the parameters within the SOPs. When you select an SOP in the SOP 
listing or in the Measuring SOP, the parameters for that SOP are displayed.

Intensity Monitor Displays the parameters that must be verified prior to measurement, such as 
the cell type, the intensity monitor (sample’s intensity), and the diluent 
properties conditions within the SOP conditions that have been registered for 
the selected SOP.

Table 1.13  Data Acquisition Measurement Screen Elements (Continued)

Screen Element Description
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One-By-One Analysis of Size and Zeta Potential

The instrument can measure particle size/zeta potential (or vice versa) one after the other when 
the same cell type and diluent are used to measure both size and zeta potential of the sample.

The instrument uses the first SOP to measure either size or zeta potential, then moves to the next 
SOP, and so on.

Figure 1.31  Measurement SOP

Checking the Cell Type, Intensity (Scattering Strength), and Diluent Properties

To check the cell type, intensity (scattering strength), and diluent properties:

1 Check the SOP parameters in the SOP Preview screen.

2 Perform the minimum checks in the Intensity Monitor at the bottom of the window.

Figure 1.32  Intensity Monitor
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Checking the Intensity (Scattering Strength) Stability

To check the intensity (scattering strength) stability:

1 Click Intensity Check in the Intensity Monitor Form. The Intensity Check screen opens.

Figure 1.33  Intensity Check Screen

2 Enter the Accum Times and click Start to perform the intensity measurement. When the 
measurement is complete, the Intensity Plot, Intensity Histogram, and Intensity Table value 
(±SD), Max (cps), and Min (cps) for the intensity appear. You can select either Auto Scale or 
Manual Scale.
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Starting the Measurement

To start the measurement:

1 Select the Measurement icon from the Data Acquisition function panel.

2 Click Start in the upper left of the Measurement screen, or select Run > Start on the Main menu 
bar.

NOTE The Start button is not displayed in other software screens, such as SOP Designer. Select the 
Measurement icon in the Data Acquisition function panel to display Start.

During the measurement, the screens that are selected in the Analysis Condition in the SOP are 
displayed. To display a graph (or graphs), click the name of the graph you want at the top of the 
screen. You can do this during a measurement. Additionally, a summary of the measurement 
parameters and conditions appears in the Results panel above the graphs.

Figure 1.34  Example Screen Display During Measurement of Particle Size
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Stopping the Measurement

To stop the measurement, click Stop in the upper left of the Measurement screen, or select Run > 
Stop on the Main menu bar.

Displaying and Printing Measurement Results

After the measurement is complete, the measurement results are displayed according to the 
analysis parameters. To change the screen display, click the buttons at the top of the screen. SOP 
settings are unaffected.

Table 1.14  Data Acquisition Measurement Screen Elements

Screen Element Description

Display Item Icons Select an icon to display or remove the desired graph or table.

Overview of 
Measurement 
Parameters and 
Measurement Status

Displays the measurement parameters and diluent properties set in the SOP; the 
intensity, cumulative number of measurement cycles, and the number of repeats 
during the measurement; and the real-time measurement results during the 
measurement are displayed.

Measurement Results 
Display Screen

Displays the graphs and tables selected in the SOP.
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Figure 1.35  Example Zeta Potential Analysis Measurement Results

When Auto Print is set to YES in the SOP, the selected results print automatically upon conclusion 
of the measurement.

To print the measurement results manually:

1 Select File > Print on the Main menu bar, or click Print at the top of the screen. A Print dialog 
opens.

2 Select the items you want to print, and click OK.

Analyzing Particle Size

Accessing Particle Size Analysis Data File Operations

To access particle size analysis data file operations, select the Size Analysis function panel. The 
Particle Size Analysis screen opens.
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Figure 1.36  Particle Size Analysis Screen

Opening a Particle Size Analysis Data File

To open a particle size analysis data file:

Table 1.15  Particle Size Analysis Screen Elements

Screen Element Description

Particle Size Analysis Data Select 
Panel

Lists the data files with these details: File Name, Group, Repet,No, 
Date&Time, User Name, Sample Info, SOP Name, pH setting and Cell 
Name.

Recalculate Condition Panel Displays particle size files for recalculation.

Data Select Panel Button Bar Use these buttons to perform data file operations:

 • Open File
 • Delete File
 • Export File
 • Import File

Analysis Results Panel Displays the details of a selected data file. For more information, see 
Opening a Particle Size Analysis Data File.
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1 In the Particle Size Analysis Data Select panel, place a checkmark next to the data file you want 
to open.

2 Click Open File. The analysis results are displayed in graphs and tables in the Analysis Results 
panel (see Figure 1.37).

Figure 1.37  Particle Size Analysis Data File Details
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Deleting a Particle Size Analysis Data File

To delete a particle size analysis data file:

1 In the Particle Size Analysis Data Select panel, place a checkmark next to the data file you want 
to delete.

2 Click Delete File. A confirmation message appears.

3 Click OK to delete the file.

CAUTION

Deleted data cannot be recovered.

Exporting a Particle Size Analysis Data File

You can export particle size analysis data files to a folder or external memory.

To export a particle size analysis data file:

1 In the Particle Size Analysis Data Select panel, place a checkmark next to the data file to export.

2 Click Export File. The Export File window opens.

3 Click Browse next to the Export File field to open the Save As dialog.

4 Select the destination, enter a file name in the Save As dialog, and click Save.

5 In the Export File window, click Export File. A status message at the bottom of the window 
indicates the completion of the export.

6 Click Close to close the Export File window.
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Importing a Particle Size Analysis Data File

Use the Import function to include exported particle size data in a data file list.

To import a particle size analysis data file:

1 Click Import File above the Particle Size Analysis Data Select panel. The Import File window 
opens.

2 Click Browse next to the Import File field to open the File Selection dialog.

3 Select the file name you want to import, and click Open.

4 In the Import File window, click Imported Selected Files. A status message at the bottom of the 
window indicates the completion of the imported.

5 Click Close to close the Import File window.

CAUTION

A file cannot be imported if it has the same name as a data file already in the list. 
Data highlighted in red text indicates that data with the same name already exists 
in the data file.

Modifying Particle Size Analysis Parameters

To modify particle size analysis parameters:

1 Click Recalculate Condition.

2 Select the set of parameters to be modified. Each of the parameters within the selected set of 
parameters appears at the bottom of the window, and the necessary parameters will be 
modified.

3 After the modification, click Recalculate to analyze the data again. The analysis results using the 
new parameters are displayed.
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Modifying All Particle Size Analysis Parameters

To modify all particle size analysis parameters:

1 Select and open the desired files and click Recalculate Condition.

2 Make the necessary changes to the condition analysis and click Recalculate All.Recalculate All 
dialog box appears.

3 Select the parameters and click OK.
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Saving the Particle Size Reanalysis Data

To save particle size reanalysis data:

1 Click Save Recalculated Data in the Particle Size Analysis Results panel. The Save Recalculated 
Data dialog opens.

2 Select either Manual Input to enter the file name, group name, and sample information, or 
select Add Numbering to append a number to the current file name or overwrite the existing 
file.

3 Click OK to save and close the dialog.

4 In 21 CFR Part 11 security mode, after recalculation and saving the data, signature, and so on, a 
Signature dialog appears. Enter the password and the reason for the changes (Comment), and 
click OK to save and close the dialog.

Overlaying Particle Size Analysis Data

You can select multiple data in the Particle Size Analysis Data Select Panel, analyze them, and 
overlay the results.

To overlay particle size analysis data:

1 Click Overlay in the Particle Size Analysis Results panel. The Particle Size Analysis Data Overlay 
dialog opens.
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Figure 1.38  Particle Size Analysis Data Overlay Dialog

2 Select the items to overlay, and click OK. The overlay in graph form appears.

Figure 1.39  Example Particle Size Analysis Overlays
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Printing Particle Size Analysis Data

To print the particle size analysis results:

1 Click Print in the upper-left of the Measurement screen, or select File > Print on the Main menu 
bar.

Figure 1.40  Data Print Dialog

2 Select the options for printing, and click OK.

Table 1.16  Data Print Dialog Options

Selection Description

Select Print Item Activates these options: 1st Figure, 2nd Figure, and Addition of Distribution Table.

1st Figure Select from Intensity Distribution, Volume Distribution, and Number Distribution. 
The item selected for the 1st figure is printed on the same sheet of paper with the 
2nd figure and the Distribution Table (if selected).

2nd Figure Select ACF or LN(G1()) vs  Plot. The item selected for the 2nd figure is printed 
on the same sheet of paper with the 1st figure and the Distribution Table (if 
selected).

Distribution Table Prints the population distribution data selected in the 1st figure, together with the 
1st figure and a 2nd figure.

1/4 Scale Distribution 
Plot

Prints on a single sheet of paper the Intensity Distribution, the Volume 
Distribution, the Number Distribution, and LN(G1()) vs  Plot.

LN(G1()) vs  Plot Prints a first-order autocorrelation logarithmic display.

G2() vs  Plot Prints a second-order autocorrelation function.

Realtime Size Monitor Prints a plot of the particle size values for each integration cycle being calculated.

Realtime Size Table Prints a table of the particle size values for each integration cycle being 
calculated.
B08631AA 1-69



Operation
Analyzing Particle Size  
Displaying the Particle Size Statistical Summary

To display the particle size measurement statistical summary:

1 Set the Statistical Summary in the Measurement Parameters to Yes. This saves all measurement 
data in the statistical summary file. This applies to new measurements using the measurement 
parameter; any previous data will not appear in the statistical summary.

2 To display the statistical summary, select the QC icon in the Size Analysis panel.

3 From the list of statistical summary files, select the files you want to open, and click Open above 
the list. In the panel on the right, a list of the measurement dates, file names, and typical data 
(typical values for the average particle sizes, multidisperse indices, and distributions) for each 
data file included in the statistical summary will be displayed.

4 To display details, select the data you want, and click Details above the summary list.

Size Dist. Table Prints distribution frequency tables for the intensity distribution, volume 
distribution, and number distribution.

Cumulative Size Dist. 
Table

Prints cumulative frequency tables for the intensity distribution, volume 
distribution, and number distribution.

ACF Listing Prints tables of the first-order and second-order autocorrelation functions.

Condition Summary Displays the measurement parameters, analysis parameters, cell parameters, 
and diluent properties extracted from the SOP parameters.

Print All Open Data Prints all data that is opened.

Table 1.16  Data Print Dialog Options (Continued)

Selection Description
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Analyzing Zeta Potential

Accessing Zeta Potential Analysis Data File Operations

To access zeta potential data file operations, select the Zeta Analysis function panel. The Zeta 
Potential Analysis screen opens.

Figure 1.41  Zeta Potential Analysis Screen
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Opening a Zeta Potential Analysis Data File

To open a zeta potential analysis data file:

1 In the Zeta Potential Analysis Data Select panel, place a checkmark next to the data file you 
want to open.

2 Click Open. The analysis results are displayed in graphs and tables (see Figure 1.42).

Table 1.17  Zeta Potential Size Analysis Screen Elements

Screen Element Description

Zeta Potential Analysis Data Select 
Panel

Lists the data files with these details: File Name, Repet. No, Date & 
Time, User Name, Sample Info, Group, and pH setting and Cell 
Name.

Recalculate Condition Panel Displays particle size files for recalculation.

Data Select Panel Button Bar Performs the following data file operations:

 • Open File
 • Delete File
 • Export File
 • Import File

Analysis Results Panel Displays the details of a selected data file. For more information, see 
Opening a Particle Size Analysis Data File.
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Figure 1.42  Zeta Potential Analysis Data File Details

Deleting a Zeta Potential Analysis Data File

To delete a zeta potential analysis data file:

1 In the Zeta Potential Analysis Data Select panel, place a checkmark next to the data file you 
want to delete.

2 Click Delete File. A confirmation message appears.

3 Click OK to delete the file.
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Exporting a Zeta Potential Analysis Data File

You can export zeta potential analysis data files to a folder or external memory.

To export zeta potential analysis data files:

1 In the Zeta Potential Analysis Data Select panel, place a checkmark next to the data files to 
export.

2 Click Export File. The Export File window opens.

3 Click Browse next to the Export File field to open the Save As dialog.

4 Select the destination, enter a file name in the Save As dialog, and click Save.

5 In the Export File window, click Export File. A status message at the bottom of the window 
indicates the completion of the export.

6 Click Close to close the Export File window.

Importing a Zeta Potential Analysis Data File

Use the Import function to include exported zeta potential analysis data in a data file list.

To import zeta potential analysis data files:

1 Click Import File above the Zeta Potential Analysis Data Select panel. The Import File window 
opens.

2 Click Browse next to the Import File field to open the File Selection dialog.

3 Select the file name you want to import, and click Open.

4 In the Import File window, click Imported Selected Files. A status message at the bottom of the 
window indicates the completion of the import.
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5 Click Close to close the Import File window.

CAUTION

A file cannot be imported if it has the same name as a data file already in the list. 
Data highlighted in red text indicates that data with the same name already exists 
in the data file.

Modifying Zeta Potential Analysis Parameters

To modify zeta potential analysis parameters:

1 Click Recalculate Condition.

2 Select the set of parameters to be modified. Each of the parameters within the selected set of 
parameters appears at the bottom of the window, and the necessary parameters are modified.

3 After the modification, click Recalculate to analyze the data again. The analysis results using the 
new parameters are displayed.

Modifying All Zeta Potential Analysis Parameters

To modify all zeta potential analysis parameters:

1 Select and open the desired files and click Recalculate Condition.

2 Make the necessary changes to the condition analysis and click Recalculate All. The Recalculate 
All window opens.

3 Select the parameters and click OK.

Saving the Zeta Potential Reanalysis Data

To save zeta potential reanalysis data:
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1 Click Save Recalculate Data in the Zeta Potential Analysis Results panel. The Save Recalculated 
Data dialog opens.

2 Select Overwrite to overwrite the data or Add Numbering to append a number extension to the 
current file name or overwrite the existing file.

3 Click OK to save and close the dialog.

In 21 CFR Part 11 security mode, after the data is recalculated and saved, a Signature dialog 
appears. Enter the password and the reason for the changes (Comment), and click OK to save 
and close the dialog.

Overlaying Zeta Potential Analysis Data

You can select multiple data in the Zeta Potential Analysis Data Select Panel, analyze them, and 
overlay the results.

To overlay zeta potential analysis data:

1 Click Overlay in the Zeta Potential Analysis Results panel. The Zeta Potential Analysis Overlay 
dialog opens.

2 Select the items to overlay, and click OK. The overlay in graph form appears.
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Figure 1.43  Example Zeta Potential Analysis Overlays
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Printing Zeta Potential Analysis Results

To print the results of a zeta potential analysis:

1 Click Print in the upper left of the Measurement screen, or select File > Print on the Main menu 
bar. The Print dialog opens.

Figure 1.44  Zeta Potential Analysis Data Print Dialog

2 Select the options for printing, and click OK.

Table 1.18  Zeta Potential Analysis Data Print Dialog Selections

Selection Description

Electrosmosis (EOS) 
Plot

Displays a table of the speed of movement for all particles within the cell, 
including an electroosmotic profile. When you select the Distribution Graph check 
box, a graph of the true zeta potential (mobility) of the particles corresponding to 
the speed of movement in the static layer position is printed on the same sheet. 
See APPENDIX D, Graphs and Table Displays.

Distribution Graph Prints a graph of the true zeta potential (mobility) of the particles corresponding 
to the speed of movement in the static layer position. See APPENDIX D, Graphs 
and Table Displays.

Peak Value Table Prints a table of zeta potentials, mobilities, and electric fields. See 
APPENDIX D, Graphs and Table Displays.

Condition Summary Displays the measurement parameters, analysis parameters, cell parameters, 
and diluent properties extracted from the SOP parameters.

Print All Open Data Prints all data that is opened.
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Displaying the Zeta Potential Analysis Statistical Summary

To display the zeta potential statistical summary:

1 Set Statistical Summary in the Measurement Parameters to Yes. This saves all measurement 
data in the statistical summary file. This applies to new measurements using the measurement 
parameter; any previous data will not appear in the statistical summary.

2 To display the statistical summary, select the QC icon in the Zeta Analysis panel.

3 From the list of statistical summary files, select the files you want to open, and click Open above 
the list. In the panel on the right, a list of the measurement dates, file names, and typical data 
(zeta potentials and electrophoretic mobilities) for each data file included in the statistical 
summary is displayed.

4 To display details, select the data you want, and click Details above the summary list.
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CHAPTER 2

Troubleshooting
Introduction

This sections lists possible malfunctions, together with probable causes and corrective actions. 
Maintenance procedures are described in CHAPTER 4, Maintenance.

Diagnostic Conditions

Diagnostic conditions appear during:

 • Instrument startup

 • Self-Diagnosis

 • Door operations

 • Communications

 • Measurements

Table 2.1  DelsaNano Diagnostics

Symptom Cause Corrective Action

Instrument does not turn on AC cable on the rear panel of the 
instrument is not connected.

Connect power cable. Verify power cable is 
plugged in securely.

The Logotype on the front 
panel does not light up

Blown fuse. Replace fuse.

If the fuse continues to blow after being 
replaced, contact Beckman Coulter Field 
Service.

The power can be switched 
on, but the Power LED does 
not light up

CPU does not start up. Contact Beckman Coulter Field Service.

Power LED does not change 
from orange to green

CPU does not start up. Contact Beckman Coulter Field Service.

Shutter 1 does not move 
correctly

Shutter movement error. Contact Beckman Coulter Field Service.

Shutter 2 does not move 
correctly

Shutter movement error. Contact Beckman Coulter Field Service.
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Shutter 3 does not move 
correctly

Shutter movement error. Contact Beckman Coulter Field Service.

Shutter 4 does not move 
correctly

Shutter movement error. Contact Beckman Coulter Field Service.

Error reading temperature Error in setting temperature constant. Verify temperature setting in SOP. If the 
problem persists, contact Beckman Coulter 
Field Service.

Malfunction of temperature sensor. Contact Beckman Coulter Field Service.

Malfunction of temperature control part 
on main board.

Contact Beckman Coulter Field Service.

Error message, dark error 
detected

Error in shutter movement. Contact Beckman Coulter Field Service.

Malfunction of Discriminator board. Contact Beckman Coulter Field Service.

Malfunction of Detector (PMT). Contact Beckman Coulter Field Service.

Malfunction of Detector (PMT). Contact Beckman Coulter Field Service.

The version of DSP is not 
correct

The slave version does not conform with 
the host.

Contact Beckman Coulter Field Service.

Instrument does not sense 
that the door is closed

The cover is open during operation of the 
instrument.

Close the cover door.

The sensor is not pushed down fully even 
though the cover is closed.

Verify that there are no obstructions to the door 
sensor and door latch. Close the door.

Malfunction of cell door sensor. Contact Beckman Coulter Field Service.

Communication failure 
between the instrument and 
the computer

Power to the instrument is not switched 
on.

Verify instrument is turned on.

USB cable is not connected. Reconnect USB cable at the DelsaNano and at 
the rear of the controller.

Instrument CPU failure. Contact Beckman Coulter Field Service.

Light intensity is too low (the 
light count is too low and the 
indicator is red at sample 
check)

Setting of ND filter is not correct. Check SOP for Intensity adjustment parameter. 
Set parameter to Yes so that the ND filter 
automatically adjusts for optimum intensity.

If the problem persists, contact Beckman 
Coulter Field Service.

The type of cell block is wrong. Check SOP parameter.

The cell block is not set correctly. Reseat measuring cell holder.

The concentration of sample is too low (at 
measurement in the cell for low 
concentration).

Increase concentration of sample.

The concentration of sample is too low (at 
measurement in the cell for high 
concentration).

Decrease concentration of sample.

The cell center is not adjusted correctly. Check SOP parameter. Verify cell type. 
Readjust cell center.

Table 2.1  DelsaNano Diagnostics (Continued)

Symptom Cause Corrective Action
B08631AA2-2



Troubleshooting
Diagnostic Conditions  2
Movement error of the shutter. Contact Beckman Coulter Field Service.

Movement error of rotating concentration 
filters on the light pass of reference light/
light for Zeta Potential.

Contact Beckman Coulter Field Service.

Light intensity is too low (the 
light count is too low and the 
indicator is red at sample 
check)

Malfunction of laser. Contact Beckman Coulter Field Service.

Light axis has shifted. Contact Beckman Coulter Field Service.

Malfunction of Discriminator board. Contact Beckman Coulter Field Service.

Malfunction of HV. Contact Beckman Coulter Field Service.

Light intensity is insufficient 
(an error message at the 
start of measurement)

Light intensity was not confirmed before 
measurement.

Confirm light intensity and adjust sample 
concentration accordingly.

“Adjustment of Light Intensity” has not 
been set to be automatic at setting of 
conditions described in SOP.

Check SOP.

Cell center adjustment has 
failed

The cell block is not set correctly. Reseat cell block into cell compartment.

The type of cell block is wrong. Check SOP.

Error in assembly of cell block. Verify cell block assembly.

Debris or dirt on the cell. Clean cell block.

Scratches on the cell Replace cell block.

Concentration of sample is too low. Increase concentration of sample.

Movement error of rotating concentration 
filter

Contact Beckman Coulter Field Service.

Movement error of cell stage Contact Beckman Coulter Field Service.

Temperature indicated on the 
display does not reach the 
set temperature

The set temperature is out of the 
specification range.

Check SOP parameter. DelsaNano specification 
is -15 C below ambient.

Contact of connector of temperature 
sensor is not secure.

Contact Beckman Coulter Field Service.

Movement of fan for heat radiation/
cooling is not correct.

Contact Beckman Coulter Field Service.

Malfunction of temperature sensor. Contact Beckman Coulter Field Service.

Malfunction of Peltier device. Contact Beckman Coulter Field Service.

Malfunction of heater. Contact Beckman Coulter Field Service.

Malfunction of temperature control part 
on the main board.

Contact Beckman Coulter Field Service.

Temperature indicated on the 
display fluctuates

Malfunction of temperature sensor. Contact Beckman Coulter Field Service.

Automatic adjustment of 
light intensity has failed

The concentration of the sample is too 
low.

Increase concentration of sample.

Range of intensity for automatic 
adjustment of light intensity is too 
narrow.

Confirm the range of intensity for automatic 
adjustment of light intensity in SOP 
parameters.

Table 2.1  DelsaNano Diagnostics (Continued)

Symptom Cause Corrective Action
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Movement error of rotating concentration 
filter.

Contact Beckman Coulter Field Service.

No voltage detected Applied voltage of SOP parameter is 
“0V”.

Check SOP.

Cell door is opened. Close cell door.

No voltage. Contact Beckman Coulter Field Service.

Measurement values of 
standard samples do not fall 
within the permissible range

Shelf life of the samples has expired. Replace sample.

The type of cell block is wrong. Check SOP.

The cell block is not installed correctly. Reinstall cell block.

There are bubbles in the cell. Remove bubbles.

The cell center is not adjusted correctly. Check SOP. Verify cell type. Readjust cell 
center.

Error in diluent properties. Check SOP. Verify diluent properties 
parameters.

Voltage applied is too high. Confirm the voltage and current values on the 
display for measurement.

Measure again at 60V for standard 
Concentration cell and at 20V for High 
Concentration cell.

Cell is not clean. Clean cell.

Instrument is affected by vibration of the 
work surface.

Remove or turn off the device that is causing 
the work surface to vibrate.

The base frequency cannot 
be stabilized

Instrument is affected by vibration of the 
work surface.

Remove or turn off the device that is causing 
the work surface to vibrate.

Malfunction of modulator. Contact Beckman Coulter Field Service.

Appearance of side peaks Problem with sample. Check purity of diluent and sample.

The instrument has been affected by 
vibration.

Remove or turn off the device that is causing 
the work surface to vibrate.

Light axis of scattered light has shifted. Contact Beckman Coulter Field Service.

Light axis of reference light has shifted. Contact Beckman Coulter Field Service.

Malfunction of modulator. Contact Beckman Coulter Field Service.

Peaks become small Light axis of scattered light has shifted. Contact Beckman Coulter Field Service.

Light axis of reference light has shifted. Contact Beckman Coulter Field Service.

A communication error with 
Auto Titrator

USB cable not connected. Reconnect USB cable from the Auto Titrator to 
the USB port on the back of the controller 
labeled Titrator.

Error of the communication port. Contact Beckman Coulter Field Service.

Table 2.1  DelsaNano Diagnostics (Continued)

Symptom Cause Corrective Action
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Sensitivity of pH Electrode 
has diminished

Lowering of sensitivity of pH electrode. 
When sensitivity is less than 90%, a 
warning appears.

 • Confirm the calibration history of pH 
electrode.

 • Exchange the inner solution (KCL solution), 
and calibrate the electrode.

 • If sensitivity does not improve, exchange 
the electrode.

Dissymmetric potential of pH 
electrode has exceeded the 
limit
(when using the Titrator/
when calibrating the pH 
sensor)

Dissymmetric potential of pH electrode 
has exceeded the limit.

 • Confirm the calibration history of pH 
electrode.

 • Exchange the inner solution (KCL solution), 
and calibrate the electrode.

 • If sensitivity does not improve, exchange 
the electrode.

Competence of pH electrode 
has exceeded the limit
(when using the Titrator/
when calibrating the pH 
sensor)

Competence of pH electrode has 
exceeded the limit.

 • Confirm the calibration history of pH 
electrode.

 • Exchange the inner solution (KCL solution), 
and calibrate the electrode.

 • If sensitivity does not improve, exchange 
the electrode.

pH cannot be measured/
Titration volume cannot be 
calculated (when using the 
Titrator)

Titration volume cannot be calculated.  • Confirm whether the concentration of 
titration solution has been set correctly. Set 
up the concentration of titration solution 
again.

 • Confirm whether the volume of sample has 
been entered correctly. Re-enter the 
sample volume.

Titration volume will exceed 
the limit

It was judged that the total titration 
volume would exceed the volume of 
sample.

 • Confirm whether the concentration of 
titration solution is consistent with that has 
been set by the software. Enter the 
concentration of titration solution to be the 
same as that has set by the software.

 • Confirm the concentration of titration 
solution. Use a titration solution of higher 
concentration.

 • Confirm whether the volume of sample 
entered to the software was correct. Enter 
the volume of sample to be entered to the 
software.

Table 2.1  DelsaNano Diagnostics (Continued)

Symptom Cause Corrective Action
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CHAPTER 3

Regulatory Compliance

This chapter describes the relevant portions of the 21 CFR Part 11 regulations and their 

implementation using the DelsaNano software.

Electronic Signatures (21 CFR Part 11)

The Electronic Records and Electronic Signatures Rule (21 CFR Part 11) was established by the FDA 
to define the requirements for submitting documentation in electronic form and the criteria for 
approved electronic signatures. Organizations that choose to use electronic records to meet record 
keeping requirements must comply with 21 CFR Part 11. Because analytical instrument systems 
such as the DelsaNano generate electronic records, these systems must comply with the Electronic 
Records Rule.

NOTE It is important to realize that implementation and compliance of the rule remains the responsibility of 
the organization or entity creating and signing the electronic records in question. Proper procedures and 
practices, such as GLP and cGMP, are as much a part of overall compliance with these regulations as are 
the features of the DelsaNano software.

Security Controls

A DelsaNano installation follows a procedure designed to ensure proper operation, maintenance 
and administration for system security and data integrity. Users interacting with the system must 
follow these procedures. The responsibility is with the organization generating electronic records 
and signatures. The DelsaNano software is a component, albeit a vital one, of the overall process.

The controls to be applied to a closed system are specified in Subpart B, Section 11.10.

System Validation

Other controls are addressed either by the DelsaNano software itself, or in combination with end 
user procedures. Most important is the validation of systems to ensure accuracy, reliability, 
consistent intended performance, and the ability to discern invalid or altered records. The 
complete and overall validation of the system, as developed by the organization, ensures the 
integrity of the system and its data. The features of the DelsaNano software are designed to comply 
with the specifications of these regulations.
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The DelsaNano software employs a system of usernames and passwords, to ensure that only 
authorized individuals can use the system, electronically sign a record, access the operation or 
computer system input or output device, alter a record, or perform the operation at hand.

File History and Tracking

File History is enabled for any file created by the DelsaNano software in 21 CFR Security mode. 
Under these conditions, all changes made to a file are automatically recorded. These changes 
consist of computer-generated, time-stamped audit trails to independently record the data and 
time of operator entries and actions that create, modify, or delete electronic records.

When a change to a file is detected, the DelsaNano software automatically records the identity of 
the user making the change, the date and timestamp of the change, the parameter that has changed, 
the old value and the new value. The user is also required to “sign” the record electronically and 
enter a reason for the change.

The audit trail is stored as History Tracking inside the file itself, so that record changes do not 
obscure previously recorded information and the file is suitable for inspection, review, and copying 
by the agency. This ensures that a complete and continuous record of all changes to the file is 
maintained.

Accessing File History

To access file history:

1 Select Option > 21 CFR Part 11 > File History on the Main Menu bar. Or, after you open a Size or 
Zeta Potential file, click File History in the upper right of the window. Figure 3.1 shows the 
location of both options.
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Figure 3.1  File History Menu Selection and File History Button

2 The File History (History Tracking) dialog opens.

Figure 3.2  History Tracking Dialog
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3 To print a copy of the file history information, click Print and Close. To close the dialog, click 
Close.

Playback

Playback is available when 21 CFR Part 11 is enabled. When selected, Playback causes the instrument 
to use Size/Zeta Potential SOP settings that were previously used to analyze the sample.

To select Playback mode:

1 Verify that 21 CFR Part 11 security is enabled.

2 Select Option > 21 CFR Part 11 > Playback on the Main menu bar. The Playback File Selection 
dialog opens.

Figure 3.3  Playback File Selection Dialog

3 Select the name of the Playback file you want, and click Open. The selected Size/Zeta Potential 
SOP for analysis is recalled. The Playback file is saved with the same sample name used during 
measurement. File extension “.PAR” indicates size SOP, and file extension “.ZETA” indicates zeta 
SOP.
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4 To return the instrument to Real mode, select Option > 21 CFR Part 11 > Playback (Real Mode).

Audit Trails

In addition to the auditing associated with the electronic file itself, the DelsaNano offers four 
additional levels of auditing, as follows. This section describes how to display the audit trails, 
change audit trail options, and export audit trail files.

 • Error audit trail stores and records errors associated with the system; for example, date/time, 
user name, communication errors, details, and so on.

 • pH Calibration audit trail stores and records pH calibration history; for example, date/time, 
user name, coefficients of acids and bases, temperature, asymmetric potential, response and 
sensitivity, and so on.

 • Operation audit trail records and stores information at a system level; for example, who logged 
in when, when users were added to the system, all operational steps, and so on.

 • Parameter audit trail stores and records parameter change history; for example, date/time, 
user name, parameter group, parameter, changed value, and so on.

Displaying the Audit Trails

To display audit trail information:

1 Select Audit Trail on the Main Menu bar. The list of audit trails appears on the drop-down menu.

2 Select the name of the audit trail to display. This opens a viewer that provides details on the 
activities for the type of audit trail you select. See Figure 3.4 for an example of the Error audit 
trail.
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Figure 3.4  Error Audit Trail

3 You can view the errors in the Error audit trail in one of two modes: All displays all errors, 
Individual User displays the errors of a particular user. To change modes, select the appropriate 
tab at the bottom of the viewer window.

4 To close the viewer window, click Exit.

Changing Audit Trail Options

To change audit trail options:

1 Select Audit Trail on the Main Menu bar. The list of audit trails appears on the drop-down menu.

2 Select the name of the audit trail to display.
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3 In the viewer window, click Options. The Options tab displays the maximum number of lines 
that have been set for each audit trail (Figure 3.5).

Figure 3.5  Audit Trail Options

4 Change the values in the fields provided, as appropriate.

5 Click Save.

Exporting Audit Trail Files

To export audit trail files:

1 Select Audit Trail on the Main Menu bar. The list of audit trails appears on the drop-down menu.

2 Select the name of the audit trail to display.
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3 In the viewer window, click Export Text. The Export tab displays fields for setting export 
options.

Figure 3.6  Audit Trail Export Text Options

4 Select the condition and the from and to dates as appropriate.

5 Click Export Text. A Windows dialog opens to allow you to select an export location and provide 
a name for the text file.

6 Click Save to export the text file. The dialog closes.

7 Click Print Preview to print the text file. A Print Preview window opens (Figure 3.7) to show the 
print results prior to printing.
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Figure 3.7  Print Preview

8 To print, click the Print icon.

Maintaining Electronic Signatures

DelsaNano software supports non-biometric signatures. Non-biometric signatures are computer 
generated and employ at least two distinct identification components such as an identification code 
and password.

Applying Electronic Signatures

There are several requirements for the control of electronic signatures. Through the application of 
DelsaNano user and password configuration procedures, the system can be configured to ensure 
that use of these identifiers by someone other than the owner can be performed only with the 
owner’s permission.
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The DelsaNano software uses the application of the username and password to authenticate the 
user making and saving the changes, in conjunction with file history and audit trails, to 
independently record the date and time of operator entries and actions that create, modify, or 
delete electronic records.

Generating Electronic Signatures

The DelsaNano software employs User IDs and passwords to verify the identify of each user logging 
into the system. 

To generate an electronic signature:

NOTE The following procedure is an example of how to generate an electronic signature. Any instance of 
data modification (for example, changing the name of a file) generates an electronic signature.

1 Select File > Open on the Main Menu bar, and select any Size or Zeta Potential data file run 
under 21 CFR Part 11 security mode from the Data Select Panel.

2 Recalculate the data.

3 Click Save Recalculated Data. The Save Recalculated Data dialog opens.

Figure 3.8  Save Recalculated Data Dialog

4 Fill in the fields provided, and click OK. The Signature dialog opens. Before a signature is 
entered, the Status field in the Digital Signature field shows “Not Signed.”
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Figure 3.9  Signature Dialog

5 Enter your Password, a Comment (required), and click OK.
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To view an added electronic signature:

1 Select Option > 21 CFR Part 11 > Signature on the Main Menu bar.

Figure 3.10  Signature Dialog Showing Digital Signature

The status (Signed), User ID, Date and Time stamp, and Comment appear in the Digital 
Signature fields.

2 Click OK to close the dialog.
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Additional Security Features

The DelsaNano software offers an important additional level of security that makes defining and 
implementing system policies easier.

Data Mirroring allows you to store files securely in a separate location. This feature is available to 
users at the Administrator or Supervisor level.

For information on configuring Data Mirroring, see CHAPTER 1, Operation
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CHAPTER 4

Maintenance

This chapter describes the maintenance procedures that should be performed regularly.
DelsaNano Care

Keep the DelsaNano clean and periodically check for spills. Be sure to power off and unplug the 
DelsaNano prior to cleaning.

Constantly monitor the equipment for the presence of foreign materials. If you discover foreign 
materials in the equipment, take appropriate measures, such as following warning labels, when 
attempting to stop the equipment.

Cleaning the Exterior of the DelsaNano

If the exterior of the equipment or the inside of the cover becomes dirty, clean by wiping with a soft 
cloth dampened with water or a neutral solvent.

Cleaning the Cell Block

If the cell block becomes dirty, clean by wiping with a soft cloth dampened with water or a neutral 
solvent. Severe buildup of dirt from fluid spills may interfere with measurements. Stop using the 
equipment if you suspect that it is not functioning normally.

Replacing the DelsaNano and Auto Titrator Fuses

The DelsaNano instrument and DelsaNano Auto Titrator each are equipped with two fuses in the 
power socket on the rear panel. Follow these steps to replace the fuses in either device.

To change the fuses:

1 Turn the power off and unplug the power cord.

2 Using a small, flathead screwdriver, pry open the fuse holder cover from the AC power input 
module.
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3 Carefully remove the fuse holder from the AC power input module.

4 Using your hands, gently remove the blown fuses and replace with two properly rated fuses (per 
the fuse rating table below).

Figure 4.1  Replacing the DelsaNano Fuses

DelsaNano Auto Titrator Care

CAUTION

The outside of the instrument is coated with a synthetic resin. Wipe spills 
immediately.

Cleaning the Auto Titrator

If the instrument surfaces or inside cover are dirty, clean by wiping with a soft cloth dampened with 
water or a neutral detergent.

Replacing the Auto Titrator Fuses

The DelsaNano Auto Titrator is equipped with two fuses in the power socket on the rear panel. For 
instructions on replacing the Auto Titrator fuses, see APPENDIX A, Auto Titrator.

Table 4.1  Fuse Rating Table

Type Current Voltage

100–120V T4A 125V

220–240V T2A 250V
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pH Electrode Maintenance

This section describes how to maintain the pH electrode.

Precautions for Daily Use

The inner solution for the reference electrode must be 3.33 mol/L KCl solution.

Use the electrode after immersion in purified water for 12 hours or more if the responding glass 
membrane of the electrode has been dried.

Do not touch the electrode connector or allow fluids to contact it.

When the inner solution does not come down to the inside of the responding glass membrane part, 
shake down the electrode two or three times, holding the cap part of the electrode.

Precautions for First-Time Use or After Long-Term Storage

For information on storing the pH electrode, see pH Electrode Storage Conditions.

1 Remove the protective cap.

2 Remove the rubber stopper for opening for draining off the inner solution with a Pasteur 
pipette.

3 Refill the inner solution.
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Figure 4.2  Refilling the pH Electrode

4 Wash the tip of the electrode with purified water, and wipe with a soft cloth.

NOTE If the inside of the protective cap becomes dried, wash the protective cap, then refill with distilled 
water until the sponge is immersed.

NOTE There may be white crystals of KCL attached to the protective cap and around the opening for 
refilling the inner solution. This is not harmful to performance. Wash the crystals off with purified 
water, and use the electrode.

pH Electrode Storage Conditions

To store the pH electrode for 2-3 weeks:

1 Wash off the sample solution well with purified water.

2 Put the rubber stopper on tightly.

3 Remove the plastic vial.

4 Replace the protective cap.

NOTE If the inside of the protective cap becomes dried, wash the protective cap, then refill with distilled 
water until the sponge is immersed.
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To store the pH electrode for longer than one month:

1 Wash off the sample solution well with purified water.

2 Put the rubber stopper on tightly.

3 Remove the plastic vial.

4 Wash the inside of the protective cap with purified water, wipe out the water, and refill with 
distilled water until the sponge is immersed.

5 Replace the protective cap.

pH Electrode Daily Maintenance

When the electrode has been used for a long time, the sample solution may contaminate the inside 
of the reference electrode, or its inner solution may become diluted. In this case, follow the steps in 
Precautions for First-Time Use or After Long-Term Storage.

Improving Response Time

If the response time or reproducibility is decreasing, follow the steps below to improve response 
time.

To improve response time:

1 Remove the rubber stopper, and suction out all the solution.

2 Reinstall the stopper and refill with new solution. Confirm that the inner solution exudes from 
the opening.

3 Repeat steps 1 and 2 several times. If performance does not improve, do one of the following, as 
appropriate:

 • To remove general dirt, wipe off with a soft cloth soaked with neutral detergent.

 • To remove oil residue, wipe off with a soft cloth soaked with an appropriate organic solvent, 
such as acetone or alcohol.

 • To remove inorganic substances, rinse with approximately 1-Normal HCI. Do not immerse 
the electrode in a concentrated acid for a long time.
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Cell Maintenance

This section contains maintenance instructions for the zeta potential measurement cells and the 
size measurement cells. The steps required for assembly, disassembly, and cleaning, where 
applicable, are included.

The zeta potential measurement cells in the DelsaNano cell listing are as follows:

 • Disposable Zeta Cell (see Disposable Zeta Cell Maintenance)

 • Flat Surface Cell (see Flat Surface Cell Maintenance)

 • High Concentration Cell (see High Concentration Cell Maintenance)

 • Flow Cell (see Flow Cell Maintenance)

 • Low Conductivity Cell (see Low Conductivity Cell Maintenance)

The size measurement cells in the DelsaNano cell listing are as follows:

 • Size Cell (Glass); see Figure 4.3.

This is a glass cuvette (minimum 0.9 mL sample required).

Figure 4.3  Size Measurement Glass Cell

 • Size Cell (Disposable); see Figure 4.4.

This is a plastic cuvette (minimum 0.9 mL sample required).

Figure 4.4  Size Measurement Disposable Cell
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 • Size Cell (Micro); see Figure 4.5.

This is a glass cuvette (minimum 0.03 mL sample required).

Figure 4.5  Size Measurement Micro Cell

 • Size Cell (Flow); see Figure 4.6.

This is a quartz cuvette (sample volume is 1.8 ml)

Figure 4.6  Measurement Size Cell (Flow)

 • Flow Cell

Measuring with Size Flow Through Cell (using pH Titrator)

This section describes how to measure with the Size Flow Cell using a pH Titrator.

1 Insert the Cell into the Cell Holder and set it to the instrument.

2 Start the DelsaNano software.

3 Click Size SOP Designer and select Size Cell (Flow) under Cell Parameters.
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4 Select Type3 or Type4 under Measurement Size Cell (Flow) Type.

5 Begin the measurement (See Measurement).

6 Analyze the measured data. (See pH Analysis).

Flow Cell Maintenance

This section describes how to disassemble and assemble the Flow Cell, as well as how to wash the 
glass cell.
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Figure 4.7  Flow Cell Components

CAUTION

Be careful not to touch the optical surfaces of the glass cell. The width of the 
optical surface is 1 mm.

Disassembling the Flow Cell

CAUTION

Use caution when disassembling the Flow Cell. There may be some residual acidic/
alkaline sample solution remaining in the Flow Cell. Wear protective gloves.

To disassemble the Flow Cell:

1. Cell Holder
2. Clamping Knob (2)
3. Packing (8); spare packing (6)
4. Electrode (2)
5. Sealing Rubber (2); spare seal (6)

6. Cell Guide (2)
7. Luer Fitting (2)
8. Glass Cell
9. Cell Stopper
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1 Drain the sample solution in the Flow Cell.

2 Remove the flow cell stopper by turning it clockwise.

3 Remove the luer fitting by turning it counter-clockwise.

4 Remove the electrode by turning the clamping knob counter-clockwise (Figure 4.8).

Figure 4.8  Removing the Electrode

5 Repeat steps 1–4 for the opposite side.

6 Holding the Flow Cell, remove the cell guides from the cell holder. Push the cell guides in while 
lifting the cell guide out of the cell holder (Figure 4.9).

Figure 4.9  Removing the Cell Guides

7 Remove the glass from the cell guide, and remove the sealing rubber from the gutter of the cell 
guide.
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Figure 4.10  Removing the Glass Cell and Sealing Rubber
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Assembling the Flow Cell

CAUTION

Be careful not to touch the optical surfaces of the glass cell. The width of the 
optical surface is 1 mm.

To assemble the Flow Cell:

1 Install the electrode packing.

Figure 4.11  Installing the Electrode Packing

2 Install the sealing rubber to the gutter of the cell guide, and insert the glass cell into the concave 
portion of the cell guide.

Figure 4.12  Installing the Sealing Rubber
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3 Insert the cell guides (holding the Flow Cell) into the cell holder firmly to the bottom of the cell 
holder, pushing the cell guides against the glass cell and fitting the trenches on the cell guides 
to the pins on the cell holder.

Figure 4.13  Inserting the Cell Guides

4 Insert the electrode into one of the cell guides, and then set the clamping knob, turning it 
clockwise.

Figure 4.14  Inserting the Electrode

5 Repeat steps 1–4 for the opposite side.

6 Set the luer fitting to the opening of the Flow Cell.
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7 Turn the luer fitting clockwise to tighten it.

Figure 4.15  Turning the Luer Fitting

8 Fill the cell with sample solution.

9 Confirm that there are no bubbles in the glass cell and between the cell holder and the glass cell.

Figure 4.16  Checking for Bubbles inside the Glass Cell
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10 Set the cell stopper in the direction shown in Figure 4.17, and turn it counter-clockwise, 
pushing lightly until it stops.

Figure 4.17  Setting the Cell Stopper

Washing the Glass Cell

Be careful not to scratch or damage the glass cell during handling.

Do not wash the cell in an ultrasonic cleaner. Wash the cell as described below.

To wash the glass cell:

1 Wash the glass cell (especially inside the cell) with purified water.

a. When the dirt inside the cell is severe, clean the inside using lens paper.

b. Dip the lens paper in acetone and wrap the lens paper around a thin wire.

2 Rinse with water again, and confirm that no lens paper fibers are remaining in the glass cell.
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CAUTION

The glass cell should be immersed in concentrated sulfuric or hydrochloric acid for 
a few hours when the dirt is especially severe. Then, wash it well with purified 
water. (When you use concentrated sulfuric or hydrochloric acid, take appropriate 
safety precautions according to your laboratory safety officer. Handling these 
acids is very dangerous.)

3 Wipe off water drops around the glass cell with lens paper.

4 Dry the glass cell in N2 flow or using a dryer. When you use N2 flow, it should be passed through 
a gas filter to reduce spots after drying. When an organic solvent is used for washing, rinse with 
acetone, and dry the cell.

5 When washing parts other than the glass cell, such as the electrode or packings, immerse the 
parts in a neutral detergent and insert into an ultrasonic washer. Rinse them well with purified 
water to remove the detergent completely.

High Concentration Cell Maintenance

This section describes how to maintain the High Concentration cell.

Disassembling the High Concentration Cell

To disassemble the High Concentration Cell:

1 Turn knob A counter-clockwise to remove electrode A.
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Figure 4.18  Removing the Electrode

2 If applicable, drain the sample solution from the cell.

3 Remove the small O-ring and sealing rubber D from knob A. Remove sealing rubber E from 
electrode A.

Figure 4.19  Removing the Small O-Ring and the Sealing Rubbers

4 Turn knob B counter-clockwise and lift up the electrode clamp.

5 Remove the transparent electrode holder.
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Figure 4.20  Removing the Transparent Electrode Holder

6 Pull the electrode rod from the transparent electrode holder, and remove the transparent 
electrode.

Figure 4.21  Removing the Transparent Electrode

CAUTION

Do not touch the surface of the electrode and the optical surface. Do not drop the 
transparent electrode. The transparent electrode is solid glass coated with 
platinum.
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7 Remove the heat conductive adapter upward, and remove the high concentration cell.

Figure 4.22  Removing the High Concentration Cell

8 Remove the large O-ring large from the high concentration cell.

Figure 4.23  Removing the Large O-Ring

9 Rinse the High Concentration Cell.

10 If the High Concentration Cell will not be used from more than a day, store the transparent 
electrode in a safe place.

11 Reassemble the High Concentration Cell without the transparent electrode.

Assembling the High Concentration Cell

To assemble the High Concentration Cell:

1 Attach the large O-ring.
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Figure 4.24  Attaching the Large O-Ring

2 Attach the High Concentration Cell to the base, and then attach the heat conductive adapter.

Figure 4.25  Attaching the High Concentration Cell to the Base

3 Attach the transparent electrode to the transparent electrode holder, fitting it into the concave 
port, and then insert the electrode rod.

Figure 4.26  Attaching the Transparent Electrode to the Holder
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CAUTION

Do not touch the surface of the transparent electrode and the optical surface. 
Confirm that the transparent electrode is parallel to the transparent cell holder 
sides.

4 Set the transparent electrode holder, lining up the convex part with the concave port in the 
base.

Figure 4.27  Setting the Transparent Electrode Holder

5 Insert the hooked clamp to the concave port in the base. Then, tighten the clamp by turning 
knob B clockwise.

Figure 4.28  Attaching the Electrode Clamp to the Base

6 Attach sealing rubber E to electrode A. Attach the small O-ring and sealing rubber D to knob A.
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Figure 4.29  Attaching the Sealing Rubber and Small O-Ring

7 Inject the sample solution into the High Concentration Cell.

Figure 4.30  Filling the High Concentration Cell with Sample Solution

8 Insert electrode A into the cell, tilting the cell slightly so that air bubbles do not enter the cell, 
and then turn knob A clockwise to install electrode A.
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Figure 4.31  Inserting the Electrode into the Cell

CAUTION

Do not confuse these sealing rubbers with those used for the other measuring 
cells.

Flat Surface Cell Maintenance

This section describes how to maintain the Flat Surface Cell for Zeta Potential.

Figure 4.32  Flat Surface Cell for Zeta Potential
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Figure 4.33  Flat Surface Cell Components

Disassembling the Flat Surface Cell

To disassemble the Flat Surface Cell:

1 Drain the sample solution from the cell. To do this, attach the silicone tube to one of the inlets 
and a syringe to the other inlet. Inject air into the cell.

1. Electrode (2)
2. Cell Holder
3. O-Ring (4)
4. Cell Block
5. Cell Seal, translucent (2)
6. Sample Sealing Block
7. Silicone Tube
8. Plug (2)

9. Luer Fitting
10. Fixing Nut (12)
11. Teflon Sheet (and Silicone Sheet)
12. Flat Surface Cell
13. Sample Fixing Block
14. Decompression Cap
15. O-Ring
16. Clamping Knob
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Figure 4.34  Removing Solution

2 Using the special tool, remove the fixing nuts, and then remove the sample fixing block. 

Figure 4.35  Removing the Sample Fixing Block

3 Remove the fixing nuts, and then remove teflon sheet or silicone sheet.

Figure 4.36  Removing the Teflon Sheet
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4 Remove the fixing nuts, then remove the sample sealing block and cell seals on both sides. 

Figure 4.37  Removing the Sample Sealing Block and Cell Seals

5 Take out the Flat Surface Cell, wash it, wrap it in lens paper, and store it in purified water. Do 
not dry the Plane Cell.

CAUTION

Handle the Plane Cell by the rough surfaces (indicated by the shaded areas in 
Figure 4.38). Exact measurements may not be possible if other surfaces contain 
fingerprints or smears. Do not dry the Plane Cell.

Figure 4.38  Plane Cell Rough Surfaces (Shaded)

6 Remove the cell block and O-rings on both sides.
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Figure 4.39  Removing the Cell Block and O-Rings

Assembling the Flat Surface Cell

All components of the Flat Surface Cell are symmetrical. Therefore, orientation of the components 
is not important, unless otherwise indicated.

To assemble the Flat Surface Cell:

1 Set up the electrode with the rough surface upward to the round concave portion of the cell 
holder.

Figure 4.40  Setting Up the Electrode

2 Install the two O-rings on both sides of the cell block, and set the Flat Surface Cell with the 
concave portion upward to the concave portion of the cell block.
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Figure 4.41  Installing the O-Rings

3 Mount the cell block on the cell holder, fitting the cut-off portions together. Then, fasten the 
fixing nut with the trenched face upward.

CAUTION

When using the special tool, do not fasten the nut too tightly. This may damage 
some parts.

Figure 4.42  Mounting the Cell Block

4 Attach a cell seal to each side of the sample sealing block. Mount the sample sealing block with 
the upper side facing up, and secure with the fixing nut.
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Figure 4.43  Attaching the Sample Sealing Block

5 Set the sample and teflon sheet (or silicone sheet) on the Flat Surface Cell.

Sample size:

 • Recommended (maximum) size: 37´16´5 mm
 • Minimum size: 33´14 mm

Sheet selection:

 • Teflon sheet: normal samples
 • Silicone sheet: samples of low strength

Figure 4.44  Setting the Samples
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6 Rotate the clamping knob of the sample fixing block counter-clockwise until it stops, and 
mount it on the sample sealing block. Fix the sample fixing block with the fixing nut. Then, 
rotate the clamping knob clockwise to make the sample contact closely with the Flat Surface 
Cell. Loosen the decompression cap to let the air out.

Figure 4.45  Mounting the Sample Fixing Block on the Sample Sealing Block

7 Insert the silicone tube (with the luer fitting) in one of the inlets. From the other inlet, fill the 
cell with the monitoring particle solution using a syringe. 

8 Remove the luer fitting and insert a plug into the inlet. Remove the syringe and put another 
plug in that inlet.

Figure 4.46  Filling the Cell with Monitoring Particle Solution
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CAUTION

Fill the monitoring particle solution slowly to prevent introducing air bubbles into 
the cell.

Washing the Flat Surface Cell

Be careful not to damage the Flat Surface Cell during handling.

Do not wash the cell in an ultrasonic cleaner. Wash the cell as described below.

To wash the Flat Surface Cell:

1 Wash the Flat Surface Cell with purified water.

CAUTION

Do not wash the cell in an alkaline solution. This may cause the coating to peel.

2 Wrap the cell with lens paper, and store it in purified water.

CAUTION

Do not wipe the cell surfaces. This may cause the coating to peel. If peeling occurs, 
you must re-coat the Flat Surface Cell.

3 Wipe off water drops around the glass cell with lens paper.

4 When washing parts other than the Flat Surface Cell, such as the O-rings, immerse the parts in 
a neutral detergent and insert into an ultrasonic washer. Rinse them well with purified water 
to remove the detergent completely.
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Coating the Flat Surface Cell with Polyacrylamide

CAUTION

Please read the vendor’s Material Safety Data Sheet (MSDS) for the Acrylamide 
before starting the procedure.

Regents:

 • 3-Methylacryloxypropltrimethoxysilane (organosilane)

 • Acrylamide-HG (acrylamide HG)

 • N,N,N’,N’–Tetramethyl-ethylenediamine (tetramethyl–ethylenediamine)

 • Potassium peroxodisulfate

 • Methanol

 • 0.1 mol/L Sodium hydroxide

 • 0.1 mol/L Hydrochloric acid

 • Concentrated sulfuric acid

Equipment:

 • Drying oven

 • Beakers as necessary

To coat the Flat Surface Cell:

1 Immerse the Flat Surface Cell in concentrated sulfuric acid for 2-3 hours. Wash it well with 
purified water, and rinse with methanol.

2 Dry the cell in N2 flow.

3 Place the cell by itself in a drying oven at approximately 160 C. Allow to dry overnight.

CAUTION

Perform steps 4-8 in a draft chamber.
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4 Remove the cell from the drying oven, and let it stand at room temperature for 15 minutes.

5 Immerse the cell in 0.1 mol/L sodium hydroxide solution for 1.5 hours.

6 Wash the cell with purified water, rinse with methanol, and dry it in N2 flow.

7 Prepare 200 mL of 60% 3–methylacryloxypropyltrimethoxysilane methanol solution. Filter the 
methanol in advance with 0.1 m filter.

8 Wash the Flat Surface Cell with the above solution approximately 10 times. Then, immerse the 
cell in the solution at approximately 30C overnight.

9 Wash the cell with methanol to remove the saline reagent which has not reacted, then wash 
with water. Then, wash the cell with methanol, and dry it in N2 flow.

10 Prepare 3.5% acrylamide solution containing 1 mg/mL potassium peroxodisulfate and 1 g/mL 
N,N,N’,N’–Tetramethyl-ethylenediamine.

11 Wash the cell with the above acrylamide solution, and immerse it in the solution for 2 hours.

12 Wash the cell with water, then with 0.1 mol/mL hydrochloric acid to remove excess acrylamide.

13 Wash the cell with water again, and wrap with lens paper. Store the cell in water to protect from 
drying.

Disposable Zeta Cell Maintenance

This section describes how to maintain the Disposable Cell for Zeta Potential measurement.
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Figure 4.47  Disposable Cell for Zeta Potential

Figure 4.48  Disposable Cell for Zeta Potential Components

1. Cell Holder
2. Large Packing
3. O-Ring
4. Knob A
5. Electrode (2)

6. Small Packing (2)
7. Knob B
8. Disposable Cell
9. Cell Cover
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Disassembling the Disposable Cell

To disassemble the disposable cell:

1 Remove the cell cover, sliding and pressing against the cell holder.

Figure 4.49  Removing the Disposable Cell Cover

2 Remove the Disposable Cell from the cell holder. Remove the electrode, turning knob A counter-
clockwise. 

Figure 4.50  Removing the First Electrode from the Disposable Cell

3 Drain the sample solution from the cell.

4 Remove the other electrode, turning knob B counter-clockwise. Remove the small packing from 
the electrode, then remove the O-ring and large packing from knob A.
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Figure 4.51  Removing the Second Electrode from the Disposable Cell

Assembling the Disposable Cell

To assemble the Disposable Cell:

1 Attach the small packing to the electrode, and insert the O-ring and large packing in knob A.

Figure 4.52  Installing the Packing and O-Rings in the Disposable Cell

2 Mount the electrode on the disposable cell, and attach knob B, turning it clockwise. Finger-
tighten gently.

CAUTION

Turn knob B until it knocks the end lightly. Do not over-tighten.
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Figure 4.53  Mounting the Electrode on the Disposable Cell

3 In the open end of the cell, inject the sample solution to the recommended volume.

Figure 4.54  Recommended Volume of Sample Solution for Disposable Cell

4 Insert the electrode into the cell, tilting the cell slightly to release air bubbles. Turn knob A to 
the right (clockwise) to secure the electrode.

Figure 4.55  Inserting the Electrode into the Disposable Cell
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5 Attach the cell to the cell holder, making sure you attach it in the proper direction.

Figure 4.56  Attaching the Disposable Cell to the Cell Holder

6 To attach the cell cover, align the trenches with the hooks in the cell holder, and slide the cover 
into place until it stops.

Figure 4.57  Attaching the Disposable Cell Cover
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Washing the Disposable Cell

When using a new sample, use a new Disposable Cell. The Disposable Cell should be used one time 
only. All other components of the Disposable Cell can be washed and reused.

CAUTION

Do not use packings from other cells.

To wash the Disposable Cell:

1 Wash the Disposable Cell with purified water.

2 To remove heavy dirt, immerse the components in a detergent, treat with ultrasound, and rinse 
thoroughly with purified water to remove all detergent.

CAUTION

Do not touch the optical surface of the Disposable Cell.

CAUTION

The cell holder is equipped with glass plates on both sides. Dry them thoroughly 
after washing. Dirt adhering to the glass plates may interfere with measurements.

Low Conductivity Cell Maintenance

This section describes how to maintain the Low Conductivity Cell for Zeta Potential measurement.

Figure 4.58  Low Conductivity Cell for Zeta Potential
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Figure 4.59  Low Conductivity Cell for Zeta Potential Components

Assembling the Low Conductivity Cell

To assemble the Low Conductivity cell:

1 Attach an O-ring to each electrode block.

Figure 4.60  Installing the O-Rings in the Low Conductivity Cell

2 Insert the glass cell into the cell holder. Orient and align the surface of the glass cell so that the 
opening is flat against the surface of the cell block.

1. Cell Holder
2. Glass Cell
3. Cell Cap

4. Electrode Block (2)
5. O-Rings (P4 perfluro)
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Figure 4.61  Inserting the Glass Cell into the Low Conductivity Cell

CAUTION

Do not touch the optical surface of the disposable cell.

3 Insert the electrode block from the side opposite the protrusion in the cell holder, and screw in 
until fully tightened.

Figure 4.62  Inserting the First Electrode Block

4 Tighten the other electrode block on the other side. Both electrode blocks are identical. There 
is no left versus right orientation.
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Figure 4.63  Inserting the Second Electrode Block

5 Put the sample into the glass cell using a pipette. The recommended usable volume range is 
1.5 mL to 2.5 mL.

Figure 4.64  Pouring Sample into the Glass Cell

6 Remove any bubbles and/or foam, and insert the cell cap. Ensure that there are no bubbles or 
foam below the Daifron plunger.
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Figure 4.65  Replacing the Cell Cap

NOTE To assemble the Low Conductivity Cell, follow the steps above in the reverse order.

Cleaning the Low Conductivity Cell

To prevent damaging the glass cell during handling, avoid using ultrasonic cleaning. Follow the 
instructions described below.

To clean the Low Conductivity Cell:

1 Rinse the glass cell thoroughly with the same solvent that was used for the dispersant of the 
sample (diluent), or with an alcohol (such as ethanol or methanol). Dry thoroughly after rinsing 
with the solvent.

2 If the inside of the glass cell is severely stained, moisten a cotton swab with ethanol or 
methanol, and wipe out the soil from the inside of the cell directly. After wiping, rinse 
thoroughly with purified water, and verify that there are no fibers from the cotton swab 
remaining in the glass cell.

CAUTION

If the glass cell is severely stained, rinse in purified water after soaking for several 
hours in concentrated sulfuric acid or concentrated hydrochloric acid. Handling 
concentrated sulfuric acid or concentrated hydrochloric acid is dangerous. 
Exercise caution.

3 Wipe up water droplets around the glass cell using lens paper.
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4 Dry the glass cell in N2 flow or using a dryer. When you use N2 flow, it should be passed through 
a gas filter to reduce spots after drying. When an organic solvent is used for washing, rinse with 
acetone and dry the cell.

5 When cleaning parts other than the glass cell (the electrodes, O-rings, and so on), soak in a mild 
detergent and perform ultrasonic cleaning, then rinse thoroughly to ensure that there is no 
residual detergent.

Low Conductivity Cell Analysis

Data obtained using the Low Conductivity cell can be analyzed by Zeta Potential Analysis. The plot 
of mobility/zeta potential distribution can be opened by Low Conductivity Cell Analysis. Select Low 
Conductivity Cell Analysis on the Main menu bar.

To obtain a Low Conductivity Cell data file:

1 Click Open from the File menu and select the desired file.

2 The saved mobility/zeta potential distribution data will be displayed. Select a file to be 
analyzed. If you select Manual Save at measurement, files will not be displayed until you save 
the results of the measurement manually.

3 Click Print to print the selected data.

4 Click Print Preview to print the data file. A Print Preview window opens to show the print 
results prior to printing.

5 Click Close to close the file.
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System Software Configuration Maintenance

System parameters, cell listing, system registration information, and data mirroring are included in 
the system configuration.

NOTE You must be an Administrator or Supervisor to change system parameters, change system registration 
information, and enable data mirroring.

System Parameters

CAUTION

The system parameters include parameters that are critical to the operation of the 
equipment. The information in Instrument Constants and Communication Ports 
should not be changed. The Options can be changed according to your particular 
needs and setup.

To view system parameters:

1 Select the Maintenance function icon panel. The System Configuration screen opens. The 
System Parameters panels open. On the left is the folder view, and on the right is a detailed view.

2 Select System Parameters in the System Configuration panel to open the detailed view.

Figure 4.66  Maintenance System Parameters
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Table 4.2  Maintenance System Parameters

Parameter Set Parameter Description

General Instrument Type Equipment model.

Language The language displayed.

Instrument 
Constants

Cell Offset X The offset value for the cell block (X axis). This value 
is set at the factory.

Cell Offset Y The offset value for the cell block (Y axis). This value 
is set at the factory.

Pinhole Offset The offset value for the origin point of the pinhole. 
This value is set at the factory.

Communication 
Ports

Main Body Port The communications (RS-232) port for 
communications with the equipment DelsaNano 
interface board.

Size Port The communications (RS-232) port for 
communications with the DelsaNano DSP board.

Titrator Port The communications (RS-232) port for 
communications with the titrator.
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Options 21 CFR Part 11 Shows if 21 CFR Part 11 is enabled.

High Sensitive PMT Select Yes if the equipment model is DelsaNano HC. 
Otherwise, select No.

Titrator Select Yes to use the titrator. Select No if you do not 
want to use the titrator.

Initial Sample Volume This refers to the initial sample volume in the sample 
vial of the Auto Titrator. This prevents the sample 
from overflowing pH titration.

pH Sensor Temp. Coefficient 
(0th, 1st, 2nd)

These are the temperature coefficients of pH sensor. 
It has 3 Coefficients with default values of (0th - 0, 1st-
1, 2nd -0)

Pump Duty (30-100%) The percentage of the pumps being used during 
titration.

Measurement Ending Buzzer Allows a buzzer to indicate the end

Measurement Type/Center 
Detection

Select Yes to see the Cell Center Detection window 
Figure 1.26 prior to the measurement.

Molecular Weight Calculation 
Unit

Allows you to select the molecular unit (kDa)

Table 4.2  Maintenance System Parameters (Continued)

Parameter Set Parameter Description
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Cell Listing

To view cell listing parameters:

1 Select the Maintenance function icon panel. The System Configuration screen opens.

2 Select Cell Listing in the System Configuration panel to open the detailed view, then select a 
specific cell to view its details.

Figure 4.67  Maintenance Cell Listing Parameters
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System Registration Information

NOTE You must be a Supervisor or an Administrator to change system registration information.

To view system registration information:

1 Select the Maintenance function icon panel. The System Configuration screen opens.

2 Select System Registration Information in the System Configuration panel. A screen showing 
the registration parameters opens.

Figure 4.68  System Registration Parameters
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APPENDIX A

Auto Titrator
Alerts for Danger, Warning, Caution, Important, and Note

DANGER

DANGER indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury. This signal word is to be limited to the most 
extreme situations.

WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury. May be used to indicate the possibility of 
erroneous data that could result in an incorrect diagnosis (does not apply to all 
products).

CAUTION

CAUTION indicates a potentially hazardous situation, which, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe 
practices. May be used to indicate the possibility of erroneous data that could 
result in an incorrect diagnosis (does not apply to all products).

IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 
Following the advice in the Important adds benefit to the performance of a piece of equipment or to a 
process.

NOTE NOTE is used to call attention to notable information that should be followed during installation, use, 
or servicing of this equipment.
B08631AA A-1



Auto Titrator
Alerts for Danger, Warning, Caution, Important, and Note  
Precautions and Environment Specifications

Read this manual completely before using the DelsaNano Auto Titrator (AT) so that you understand 
fully how to operate the instrument.

Site requirements:

 • Avoid inclination, vibration, and shock during operation and transport. Position the Auto 
Titrator on a stable, level surface.

 • Set up the instrument in a place free from the effects of pressure, extreme temperatures and 
humidity, poor ventilation, sunlight, dust, or salty or sulfurous air.

— Surrounding temperature: 15-35 C

— Relative humidity: 30-85% (without condensation)

 • Set up this instrument considering the frequency and voltage of power supply and allowable 
electric current. Confirm the status of electric discharge and polarity when a battery is to be 
used as the power supply.

— Rated voltage: AC 100-230V, 50/60 Hz

— Rated electricity consumption: 55 VA

 • Do not set up the instrument in a strong magnetic or electric field.

 • Do not set up the instrument in a place where chemicals are stored or where chemical gases 
may be generated.

 • Do not set up the instrument in a place where it will be splashed with water.

 • Do not set up the instrument near the blowout hood of an air conditioner.

 • Connect the ground wire correctly.

 • Maintain the specified clearances around the instrument shown in Figure A.1.

Figure A.1  Auto Titrator Setup Clearances
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Prior to using the Auto Titrator, check the following:

 • Confirm that there is no damage on the surface of the instrument and no extraneous substances 
inside the instrument.

 • Confirm that the instrument runs normally, including all switch contacts.

 • Confirm that the instrument is grounded properly.

 • Confirm that all electric cords are connected properly and securely.

During use, take note of the following:

 • Be aware of proper instrument function at all times.

 • Do not touch any operational parts other than those specified in the instructions.

 • Operate the instrument appropriately; stop the instrument when you observe any abnormal 
instrument functions.

 • Do not use electric devices that use radio waves around the instrument.

 • Operate the instrument according to instructions printed on the labels attached to the 
instrument.

If any problems occur, stop operation immediately and contact your Beckman Coulter 
representative.

Do not disassemble the instrument.
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Auto Titrator and pH Electrode Components

The components of the Auto Titrator are shown below.

Figure A.2  Auto Titrator Components

1. pH Electrode
2. Vial (plastic)
3. LED for Stirrer
4. Stirrer Switch
5. LED for Titration

6. Vial (glass)
7. Syringe Cover
8. Top Panel
9. Air Bubble Trap
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The components of the pH electrode are shown below.

Figure A.3  pH Electrode Components

Stirrer LED Indicators

Use the Power switch to turn the power On/Off. Once the power is On, you can rotate the switch to 
the right (clockwise) to adjust the speed of the Stirrer from minimum (MIN) to maximum (MAX). 
Minimum power is the Off position.

Titration LED Indicators

1. Protective Cap
2. Contact Portion to Solution
3. Responding Glass Membrane
4. Connector for temperature sensor
5. Electrode Connector

6. Connector Protective Cover
7. Lead Wire
8. Cap
9. Rubber Stopper for Refill Opening (Inner Solution)

Table A.1  Stirrer LED Status Indicators

LED Type Status of Instrument

STIRRER Green: Stirrer On
Off: Stirrer Off

Table A.2  Titration LED Status Indicators

LED Type Status of Instrument

(1), (2), (3) Green: Instrument startup is complete.
Blinking in Green: During instrument startup, or during dispensing sample solutions.
Off: Power Off, or no vial is selected.
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CAUTION

Each LED corresponds to the vial just under the LED. Be careful not to switch the 
tubing.

Preparing for Measurement

Inspecting the pH Electrode

Remove the pH electrode by sliding it upward and rotating the vial (plastic) to the right (looking 
down). Confirm the volume of inner solution in the pH electrode. If the volume has decreased, refill 
the inner solution (3.33 mol/L KCl solution) by removing the rubber stopper from the refill opening 
(for refilling the inner solution).

Figure A.4  Inspecting the pH Electrode
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CAUTION

The inner solution for the electrode is KCl solution of high concentration
(3.33 mol/L). If your hands/skin contact the inner solution, wash your hands/skin 
under running water immediately. If the inner solution enters your eye(s), wash 
with running water immediately, and seek medical attention.
The outer tube and tip of the electrode are made of glass. Be careful not to break 
the glass. 

Setting the pH Configuration

You can set acid/base/other solutions such as additive for the titration.

To set the pH Configuration:

1 Select Configuration in the pH Maintenance window.

Figure A.5  pH Configuration Dialog

2 Select the vial position number to which acid, base, or other solution is to be set and select the 
type of solution. Then enter the molar concentration for each solution.

If a vial is not going to be used, deselect the vial position number.

3 Select the type of vial to be used: 50 mL or Beaker.
B08631AA A-7



Auto Titrator
Preparing for Measurement  
4 When finished, click OK to accept your changes and close the dialog.

Calibrating the pH Electrode

Calibrate the pH electrode before starting measurement. Calibration is not required for each 
measurement, but it should be done once a day, for example, before the first titration.

Priming

When the instrument is used for the first time, or when the titration solution is exchanged for 
another solution, fill the solution according to the procedures described below.

1 Pour the titration solution into the glass vial or plastic vial and put the cap on. Use the glass vial 
if the titration solution will be used continuously for more than one day. You can use plastic 
vials if using the titration solution for a shorter time.

Figure A.6  Glass Vial

Figure A.7  Plastic Vial
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CAUTION

Be careful not to swap the Teflon tube when pouring the titration solution. If tubes 
are mistakenly inserted into the wrong vial, exact titration cannot be done.

2 Set a beaker for waste fluid underneath the sample vial setting portion.

3 Select Priming in the pH Maintenance window. The Priming Dialog opens.

Figure A.8  Priming Dialog

4 Select the vial number, and click Start. The solution will start filling. Click Stop after 
confirmation that no air remains in the tube. After completion of filling, click Close to return to 
the previous window.

Pouring the Sample Solution

To pour the sample solution:

Set the stirrer into the vial and pour in the sample solution. Set the vial, and slide the electrode 
holder down until it reaches the bottom.
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Figure A.9  Pouring the Sample

Circulating the Sample

To circulate the sample:

1 Select Circulation of Sample from the Sample Circulation of pH Maintenance window. The 
Sample Circulation dialog opens.

Figure A.10  Sample Circulation Dialog

2 Set Duty (pump speed) for circulation. You can select a Duty range of 30-100%. The larger the 
value, the faster the circulation speed. It is recommended that you select 50 when filling the 
sample solution.

3 Click Start to start circulation.
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4 Click Close to close the dialog.

Degassing the Tube

To degass the tube:

1 Tilt the air bubble trap, holding the outlet side upright while the sample solution is circulating.

Figure A.11  Degassing the Tube, Step 1

2 When you see no bubbles in the outlet, return the air bubble trap to a horizontal, level position. 
Then put the trap on the holder.

Figure A.12  Degassing the Tube, Step 2
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CAUTION

Be sure that degassing is complete. Air bubbles in the tube might enter the cell of 
the Titrator and cause inaccurate measurements.

Degassing the Glass Cell

To degass the glass cell:

1 Tilt the cell holding the outlet side upright while the sample solution is circulating.

Figure A.13  Degassing the Glass Cell, Step 1

2 When you see no bubbles in the outlet, return the cell to a horizontal, level position.

Figure A.14  Degassing the Glass Cell, Step 2
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3 Remove the cell stopper and confirm that there are no bubbles inside the glass cell and between 
the cell holder and glass cell.

If bubbles cannot be removed, shake the cell gently or tap the side or bottom of the cell with 
your palm to remove bubbles.

Figure A.15  Checking for Bubbles inside the Glass Cell

4 Insert the cell into the cell temperature control block.

Figure A.16  Cell Temperature Control Block
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When measurement preparations are complete, start the measurement. First you must confirm the 
parameters used for the measurement.

Setting Measurement Conditions

Confirm the following prior to starting a measurement: Selection of Cell, Scattering Light Intensity, 
Diluent Properties, and Measurement Routine. 

Figure A.17  Intensity Monitor

Figure A.18  Intensity Measurement Parameters
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Preparing for pH Titration

The following modes are available for pH Titration:

 • pH Titration — A mode to adjust pH as prescribed for measurement of Zeta Potential/Size.

 • Pipetting — A mode to add additive(s) as prescribed for measurement of Zeta Potential/Size.

 • Circulation — A mode to measure Zeta Potential/Size, circulating sample solution for the 
prescribed period.

Figure A.19  Titrator Modes

This section describes how to prepare the Titration mode.

Preparing the Titration Mode

To prepare the Titration mode:

Table A.3  Intensity Measurement Parameters

Selection Description

Selection of Cell Ensure that the Flow cell/Size cell (Flow) are displaying.

Scattering Light Intensity The appropriate light intensity is 3000 – 30000 cps. Confirm that 
the light intensity is within this range. If the light intensity is over 
or under this range, check that the “Adjustment of ND Filter” is set 
to “Automatic Adjustment.” If the light intensity is out of the 
appropriate range, even though it is set to “Automatic 
Adjustment,” then adjust the concentration of the sample solution.

Diluent Properties Select the solvent that is used for sample solution.

Measurement Routine When you use pH titration, confirm that the appropriate routine 
has been selected. There is a special routine for pH titration. For 
details of the routine, see Preparing for pH Titration.
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1 Select the cell parameters you want to use.

NOTE If the cell is used in an SOP that is registered or being using in a measurement, you must delete 
the cell parameter from that SOP in order to edit the cell parameters.

2 Under the Titrator section of the cell parameters, select pH Titration.

3 Under the pH Titration section of the cell parameters, click Browse next to pH Table.

Figure A.20  pH Table Selection

The pH Table dialog opens.
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Figure A.21  pH Table Dialog

4 Input the pH values to be attained in the pH table.

5 Click OK to accept the values and close the dialog.

6 Adjusting the pH value is considered complete when the pH value falls within the prescribed pH 
allowance value. The smaller the allowance value, the more exactly the adjustment can be done. 
The default value should be “0.1” if no other value is specifically required. This is because when 
the value is smaller than the default, it takes time to adjust the system manually.

7 Set the appropriate measurement type. The measurement types available for use with the Auto 
Titrator are types 3 and 4.

8 Once you’ve completed your modifications, insert the modified cell parameter into a Size/Zeta 
SOP to be used in a measurement.

Starting the Measurement

When you’ve completed setting the conditions (such as preparation/selection of routine), click 
Start to begin the measurement.
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pH Analysis

Data obtained using the Auto Titrator can be analyzed by Zeta Potential Analysis. The plot of 
isoelectric points can be opened by pH Analysis. Select pH Analysis on the Main menu bar.

To open a titration file:

1 Select Open from the File menu and select the desired file.

2 The saved pH titration data (isoelectric points) will be displayed. Select a file to be analyzed. If 
you select Manual Save at measurement, files will not be displayed until you save the results of 
the measurement manually.

Figure A.22  pH Graph (Zeta Potential)

The data you selected will be displayed and the isoelectric points will be calculated. In addition, 
this window calculates and displays the plot of isoelectric points when you input Zeta Potential 
values, using pH values displayed in the window.

3 Similarly, you can perform analysis pH vs. Size titration and pH vs. Size and Zeta Potential.
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Figure A.23  pH Graph (pH vs. Particle Size)

4 To create a pH graph showing Size vs. Zeta Potential, select New in the pH Analysis tab, then 
select pH - Zeta Potential vs. Particle Size graph. Enter the desired values.

Figure A.24  pH Analysis Mode Selection Dialog

5 Select the desired mode, and click OK. A window for data input displays.
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Figure A.25  pH Graph (Zeta Potential vs. Particle Size)

Calibration of pH Electrode

Calibrating the pH Electrode

To calibrate the pH electrode:

1 pH Standard Solution

You need commercial pH standard solutions to calibrate the pH electrode. Two or three kinds 
of pH standard solutions are used for pH calibration (2-point or 3-point calibration). In either 
case, standard solution of pH 6.86 or pH 7.00 (phosphate) is necessary for both 2-point and 
3-point calibration.

2 pH Calibration

Select the pH Calibration icon in the pH Maintenance function panel. The pH Calibration dialog 
opens.

Select the Number of Points (2 or 3 points) for pH calibration using the drop-down menu.
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Figure A.26  pH Calibration Dialog

First, set the standard solution of pH6.86 (phosphate) to the sample vial and select Buffer 1. 
Then, click Start.

A progress bar at the bottom of the screen displays during standard solution measurement. 
Measurement ends automatically when the potential becomes stable.

Next, pH measurements should be done with pH4 standard (phthalate) and pH9 standard 
(borate). After the end of measurements with the three standard solutions, the results display 
on the lower part of the pH Calibration dialog.

Click Registration to save the results of calibration in the pH Calibration Audit Trail. Otherwise, 
the results of calibration will not be saved.
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Figure A.27  pH Calibration Log Viewer

NOTE When a value out of the specified range for the following items is found in the pH Calibration Audit 
Trail, this means that an abnormality may have occurred in the electrode. Wash the electrode and 
exchange the inner solution, then perform the pH calibration again.

 • Asymmetry Potential: Specified range of potential: ±30 mV at pH 7.

 • Sensitivity: Difference between actual and calculated values for electromotive force between 
pH 7 and pH 4: Specified range: more than 90%.
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Temperature Constants of pH Electrode

When a new electrode is used, the temperature constants of the original pH electrode become 
invalid, though they were set at shipment. In this case, reset the titrator temperature constants in 
the System Maintenance Input for Instrument window as follows: the “0th” temperature constant 
= “0,” “1st” = “1,” and “2nd” = “0.”

Figure A.28  Temperature Constants of pH Electrode

Maintenance and Inspection

Cleaning the Instrument

If the outside of the instrument or inside of the cover is dirty, wipe the dirt off with a soft cloth 
dampened with water or neutral detergent.

CAUTION

The outside of the instrument is coated with a synthetic resin. Wipe off any 
solution spills immediately.

Replacing the Fuses

The instrument is equipped with two fuses in the power socket on the rear panel.

To change the fuses:

1 Turn the power off and unplug the power cord.

2 Using a small, flathead screwdriver, pry open the fuse holder cover from the AC power input 
module.

3 Carefully remove the fuse holder from the AC power input module.

4 Using your hands, gently remove the blown fuses and replace with two properly rated fuses (per 
the fuse rating table below).
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Figure A.29  Replacing the Auto Titrator Fuses

Consumable Supplies

Consumable supplies are listed in Table A.5. Please contact your Beckman Coulter representative to 
reorder consumables according to the exchange limit and life span information in Table A.5.

pH Electrode Maintenance

Precautions for Daily Use

 • Inner solution for the reference electrode must be 3.33 mol/L KCL solution.

 • Immerse the electrode in purified water for 12 hours or more if the glass membrane of the 
electrode has dried out.

 • Do not touch the electrode connector or allow fluids to contact it.

 • When the inner solution does not come down to the inside of the responding glass membrane, 
shake down the electrode two or three times, holding the cap part of the electrode.

Table A.4  Fuse Rating Table

Type Current Voltage

100-120V T4A 125 V

220-240 T2A 250 V

Table A.5  Consumable Supplies

Item Approximate Exchange Limit or Life Span

Tube (1), (2) Every exchange of titration solution

Tube (3), (5)–(9) Every exchange of sample solution

Tube (4) 1 Month

Syringe Packing 6 Months
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Precautions for First-Time Use or After Long-Term Storage

For information on storing the pH electrode, see pH Electrode Storage Conditions.

1 Remove the protective cap.

2 Remove the rubber stopper for opening for draining off the inner solution with a Pasteur 
pipette.

3 Refill the inner solution.

Figure A.30  Refilling the pH Electrode

4 Wash the tip of the electrode with purified water, and wipe with a soft cloth.

NOTE If the inside of the protective cap dries out, wash the protective cap and then refill it with distilled 
water until the sponge is immersed.

NOTE There may be white crystals of KCL attached to the protective cap and around the refill opening. 
This is not harmful to performance. Wash the crystals off with purified water and use the electrode.
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pH Electrode Storage Conditions

To store the pH electrode for longer than two weeks:

1 Wash the sample solution with purified water.

2 Put the rubber stopper on tightly.

3 Remove the plastic vial.

4 Replace the protective cap.

NOTE If the inside of the protective cap dries out, wash the protective cap and then refill it with distilled 
water until the sponge is immersed.

pH Electrode Daily Maintenance

When the electrode has been used for a long time, the sample solution may contaminate the inside 
of the reference electrode or its inner solution may become diluted. In this case, follow the steps in 
Precautions for First-Time Use or After Long-Term Storage.

Improving Response Time

If the response time or reproducibility is decreasing, follow the steps below to improve response 
time. 

To improve response time:

1 Remove, then reinstall the rubber stopper.

2 Confirm that the inner solution exudes from the opening.

3 Repeat steps 1 and 2 several times. If performance does not improve, do one of the following, as 
appropriate:

 • To remove dirt, wipe off with a soft cloth soaked with a neutral detergent.

 • To remove oil residue, wipe off with a soft cloth soaked with an appropriate organic solvent, 
such as acetone or alcohol.

 • To remove inorganic substances, rinse with approximately 1-Normal HCL. Be sure not to 
immerse the electrode in a concentrated acid for a long time.
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Diluent Physical Constants
Introduction

There are several types of physical constants used in particle characterization using light scattering 
technologies, including laser diffraction, photon correlation spectroscopy, and electrophoretic light 
scattering. The physical constants include values of refractive index, viscosity and dielectric 
constant for different substances. The values listed here are selected from various sources, 
including handbooks and internet sources. For several types of materials, more complete lists can 
be found from the following:

 • Handbook of Chemistry and Physics, CRC Press, Boca Raton;

This handbook is revised and published every year. The following tables are particularly useful 
in particle characterization:

Physical Constants of Inorganic Compounds

Physical Constants of Minerals

Carbohydrates: Waxes

Index of Refraction of Organic Compounds

Optical Properties of Metals

 • Polymer Handbook, Eds. Brandrup, J., Immergut, E. H., Grulke, E. A., 4th Ed., Wiley-Interscience, 
New York, 1999.

 • Handbook of Optical Constants of Solids, Ed. Palik, E. D., Academic Press, New York, 1997.

 • Pigment Handbook, Ed. Lewis, P. A., John Wiley & Sons, New York, 1988.

Water

Refractive Index

Refractive index is the ratio of the wavelength or phase velocity of an electromagnetic wave in a 
vacuum to that in the substance. It is a function of wavelength, temperature, and pressure. If the 
material is non-absorbing and non-magnetic at any wavelength, then the square of refractive index 
is equial to the dielectric constant at that wavelength. For absorbing materials, the complex 
refractive index m = ik is related to the absorptive index k, where the real term describes the 
refraction and the imaginary term describes the absorption. The following empirical equation, from 
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Water  
International Critical Tables Of Numerical Data, Physics, Chemistry and Technology, National Research 
Council (U.S.), McGraw-Hill, New York, 1926-30, describes the refractive index of water as a function 
of wavelength () in microns and temperature. In the temperature range from 0 C to 50 C and 
wavelength range from 0.4 m to 0.7 m, the values computed from the formula are accurate up to 
five significant figures as compared with the numerical values in the CRC Handbook of Chemistry and 
Physics, CRC Press, Boca Raton, 1999.

Equation 16

Viscosity

Viscosity is a measure of a fluid’s resistance to flow. It describes the internal friction of a moving 
fluid. Viscosity is expressed in dyne-seconds per cm2 or poises (g/cm’s). The common unit for 
viscosity in centipoise (cp), which is equal to 0.01 poise. Kinematic viscosity is the ratio of viscosity 
to density in stokes (cm2/s). The following empirical equations are for the viscosity of water in 
centipoises at different temperatures. Equation 17 is for the temperature range from 0 C to 20 C, 
from Hardy, R. C., Cottington, R. L., J. Res. NBS, 1949, 42, 573; and Equation 18 is for the temperature 
range from 20 C to 100 C, from Swindells, J. F., NBS. This viscosity at 20 C is 1.002 cp.

Equation 17

Equation 18

Dielectric Constant

Dielectric constant is a measure of the amount of electrical charge a given substance can withstand 
at a given electric field as compared to air. The following empirical equation is from Maryott and 
Smith, NBS Cir. 514, 1951. In the temperature range from 0 C to 60 C, the values computed from the 
formula are accurate up to four significant figures as compared with the numerical values in the CRC 
Handbook of Chemistry and Physics, CRC Press, Boca Raton, 1999. 

Equation 19
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Other Liquids

Table B.1  Other Liquids

Liquid T(C) (CP) R.I. Dielectric 
Constant

1,1,2,2-Tetrabromoethane 25 9.00 1.6380 7.0

1,1,2,2-Tettrachloroethane 15 1.844 1.4944 7

1,2-Dichloroethane 25/50 .464/.362 1.4443 9.3

1,2-Propanediol 25 40.4 1.4324 32

1-Octanol 25/50 7.288/3.232 1.4293 10

1-Propyl Alcohol 20/30 2.231/1.72 1.3854 20

2,2,4-Trimethylpentane 20 .5 1.3916 1.94

2-Ethoxyethanol 20 1.72 1.402 16.9

2-Propyl Alcohol 15/30 2.86/1.77 1.377 18

Acetaldehyde 10/20 .255/.22 1.3316 22

Acetic Acid 18/25 1.30/1.16 1.3718 6.15

Acetic Anhydride 18/50 .90/.62 1.3904 20

Acetone 20/25 .326/.316 1.3589 20.7

Acetonitrile 20/25 .360/.345 1.3460 37.5

Acetophenone 20/25 1.8/1.62 1.5342 17.4

Allyl Alcohol 20/30 1.363/1.07 1.4135 22

Amyl Acetate(iso) 20 .867 1.4012 7.252

Aniline 20/50 4.40/1.85 1.5863 6.89

Anisole 20 1.32 1.5179 4.3

Benzaldehyde 20/25 1.6/1.35 1.5463 17.8

Benzene 20/50 .652/.436 1.5011 2.28

Benzyl Alcohol 20/50 5.8/2.57 1.5396 13.1

Benzylamine 20 1.59 1.5401 4.6

Bromobenzene 15/30 1.196/.985 1.5602 5.5

Bromoform 15/25 2.15/1.89 1.5980 4.4

Carbon Disulfide 20/40 .363/.330 1.6280 2.64

Carbon Tetrachloride 20/50 .969/.654 1.4630 2.24

Castor Oil 25 600 1.47 4.0

Chlorobenzene 20/50 .799/.58 1.5248 2.71

Chloroform 20/25 .580/.542 1.4464 4.81

Cyclohexane 17/20 1.02/.696 1.4264 2.02

Cyclohexanol 25/50 47.5/12.3 1.4655 15
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Cyclohexanone 15/30 2.435/1.803 1.451 18.3

Cyclohexene 20/50 .696/.456 1.4451 2.02

Cyclopentane 20 .44 1.406 1.97

Delphi Liquid 20 1.2718

Dibutyl Phthalate 25/50 16.6/6.47 1.4900 ~ 8

Dichloromethane 15/30 .449/.393 1.4244 9.09

Diethylamine 25 .346 1.3864 3.7

Dimethyl Sulfate 15/30 2.0/1.57 1.3874 55

Dimethyl Sulfoxide 25 2.0 1.47 4.7

Dimethylaniline 20/50 1.41/.9 1.5582 4.4

Dimethylformamide 25 .802 1.42 36.7

Dioxane 15/25 1.44/1.177 1.4175 2.2

Ether (Di-Ethyl) 20/25 .233/.222 1.3497 4.3

Ethyl Acetate 20/25 .455/.441 1.3722 6.0

Ethyl Alcohol 20/30 1.2/1.003 1.3611 25

Ethyl Benzene 17/25 .691/.640 1.49 2.5

Ethyl Bromide 20/25 .402/.374 1.4239 4.9

Ethylene Bromide 20 1.721 1.5379

Ethylene Glycol (100%) 20/30 19.9/12.2 1.4627 38.7

Ethylene Glycol (70%) 20/30 7.11/5.04 1.4627

Ethylene Glycol (50%) 20/30 4.2/3.11 1.4627

Ethylene Glycol (20%) 20/30 1.835/1.494 1.4627

Ethylene Glycol (10%) 20/30 0.8120/0.699 1.4627

Formamide 20/25 3.76/3.30 1.4453 84

Formic Acid 20/50 1.80/1.03 1.3714 58

Freon (11 and 13) 25 .415 1.36 3.1

Furfural 20/25 1.63/1.49 1.5261 42

Glycerin (100wt%) 20/25 1499/945 1.4729 42.5

Glycerin (99wt%) 20 1.4723

Glycerin (98wt%) 20 1.4707

Glycerin (97wt%) 20 1.4691

Glycerin (96wt%) 20 1.4675

Glycerin (95wt%) 20 1.4660

Glycerin (94wt%) 20 1.4644

Glycerin (93wt%) 20 1.4629

Table B.1  Other Liquids (Continued)

Liquid T(C) (CP) R.I. Dielectric 
Constant
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Glycerin (92wt%) 20 1.4614

Glycerin (91wt%) 20 1.4599

Glycerin (90wt%) 20 1.4584

Glycerin (89wt%) 20 1.4569

Glycerin (88wt%) 20 1.4554

Glycerin (87wt%) 20 1.4539

Glycerin (86wt%) 20 1.4524

Glycerin (85wt%) 20 1.4509

Glycerin (84wt%) 20 1.4493

Glycerin (83wt%) 20 1.4477

Glycerin (82wt%) 20 1.4461

Glycerin (81wt%) 20 1.4445

Glycerin (80wt%) 20 1.4429

Glycerin (79wt%) 20 1.4414

Glycerin (78wt%) 20 1.4398

Glycerin (77wt%) 20 1.4383

Glycerin (76wt%) 20 1.4368

Glycerin (75wt%) 20 1.4353

Glycerin (74wt%) 20 1.4339

Glycerin (73wt%) 20 1.4324

Glycerin (72wt%) 20 1.4309

Glycerin (71wt%) 20 1.4294

Glycerin (70wt%) 20 1.4279

Glycerin (69wt%) 20 1.4264

Glycerin (68wt%) 20 1.4249

Glycerin (67wt%) 20 1.4234

Glycerin (66wt%) 20 1.4219

Glycerin (65wt%) 20 1.4204

Glycerin (64wt%) 20 1.4190

Glycerin (63wt%) 20 1.4175

Glycerin (62wt%) 20 1.4160

Glycerin (61wt%) 20 1.4145

Glycerin (60wt%) 20 1.4130

Glycerin (59wt%) 20 1.4115

Glycerin (58wt%) 20 1.4100

Table B.1  Other Liquids (Continued)

Liquid T(C) (CP) R.I. Dielectric 
Constant
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Glycerin (57wt%) 20 1.4085

Glycerin (56wt%) 20 1.4070

Glycerin (55wt%) 20 1.4055

Glycerin (54wt%) 20 1.4041

Glycerin (53wt%) 20 1.4026

Glycerin (52wt%) 20 1.4011

Glycerin (51wt%) 20 1.3996

Glycerin (50wt%) 20 1.3981

Glycerin (49wt%) 20 1.3966

Glycerin (48wt%) 20 1.3951

Glycerin (47wt%) 20 1.3937

Glycerin (46wt%) 20 1.3923

Glycerin (45wt%) 20 1.3909

Glycerin (44wt%) 20 1.3895

Glycerin (43wt%) 20 1.3882

Glycerin (42wt%) 20 1.3868

Glycerin (41wt%) 20 1.3855

Glycerin (40wt%) 20/25 3.750/3.181 1.3841

Glycerin (39wt%) 20 1.3828

Glycerin (38wt%) 20 1.3814

Glycerin (37wt%) 20 1.3809

Glycerin (36wt%) 20 1.3787

Glycerin (35wt%) 20 1.3774

Glycerin (34wt%) 20 1.3761

Glycerin (33wt%) 20 1.3747

Glycerin (32wt%) 20 1.3734

Glycerin (31wt%) 20 1.3720

Glycerin (30wt%) 20/25 1.3707

Glycerin (29wt%) 20 1.3694

Glycerin (28wt%) 20 1.3680

Glycerin (27wt%) 20 1.3667

Glycerin (26wt%) 20 1.3654

Glycerin (25wt%) 20 1.3640

Glycerin (24wt%) 20 1.3627

Glycerin (23wt%) 20 1.3614

Table B.1  Other Liquids (Continued)

Liquid T(C) (CP) R.I. Dielectric 
Constant
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Glycerin (22wt%) 20 1.3601

Glycerin (21wt%) 20 1.3588

Glycerin (20wt%) 20/25 1.769/1.542 1.3575

Glycerin (19wt%) 20 1.3562

Glycerin (18wt%) 20 1.3549

Glycerin (17wt%) 20 1.3536

Glycerin (16wt%) 20 1.3523

Glycerin (15wt%) 20 1.3511

Glycerin (14wt%) 20 1.3498

Glycerin (13wt%) 20 1.3485

Glycerin (12wt%) 20 1.3473

Glycerin (11wt%) 20 1.3460

Glycerin (10wt%) 20/25 1.311/1.153 1.3448

Glycerin (9wt%) 20 1.3436

Glycerin (8wt%) 20 1.3424

Glycerin (7wt%) 20 1.3412

Glycerin (6wt%) 20 1.3400

Glycerin (5wt%) 20 1.3388

Glycerin (4wt%) 20 1.3376

Glycerin (3wt%) 20 1.3365

Glycerin (2wt%) 20 1.3353

Glycerin (1wt%) 20 1.3342

Heptane 20/25 .409/.386 1.3876 1.92

Hexane 20/25 .326/.294 1.3754 1.89

Iodoethane 25/50 .556/.444 1.5168 7.4

Isobutyl Alcohol 15/20 4.703/3.9 1.3968 15.8

Isopar G 20/40 1.491/1.12 1.4186 2.0

Isopar M 37.8 34-36.5 1.4362

Isopentane 20 .223 1.3550

Isopropyl Alcohol 15/30 2.861/1.77 1.377 18

Isopropyl Ether 25/50 .396/.304 1.3680 3.85

Iso-Propylacetate 20 .525 1.377

m-Bromoaniline 20 6.81 1.6260 13

Methanol 20/25 .597/.547 1.3312 33.6

Methyl Acetate 20/40 .381/.320 1.3614 7

Table B.1  Other Liquids (Continued)

Liquid T(C) (CP) R.I. Dielectric 
Constant
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Methyl Cyclohexane 25/50 .679/.501 1.4253 2

Methyl Ethyl Ketone 20/50 .42/.31 1.38 19

Methyl Iodide 20 .500 1.5293 7.0

Methyl Isobutyl Ketone 20/50 .579/.542 1.396 18

Methylacetate 20/50 .381/.286 1.3594 6.7

Methylene Chloride 15/30 .449/.393 1.4237 9.08

m-Toluidine 20 .81 1.5711 6.0

m-Xylene 15/20 .650/.620 1.4972 2.37

n-Amyl Alcohol 20/50 2.948/1.42 1.4099 13.9

n-Butyl Acetate 20 .73 1.3951 5.0

n-Butyl Alcohol 20/50 2.948/1.42 1.3993 17.8

n-Decane 20/50 .92/.615 1.4120 2.0

Nitrobenzene 20/50 2.0/1.24 1.5529 35

Nitromethane 20/25 .66/.620 1.3818 39.4

n-Nonane 20/50 .711/.492 1.4054 1.972

n-Octane 20/50 .542/.389 1.3975 2.0

n-Pentane 0/20 .277/.240 1.3570 1.84

n-Propylacetate 20/50 .537/.39 1.384 6.3

o-Dichlorobenzene 25 1.32 1.5515 99

o-Nitrotoluene 20/40 2.37/1.63 1.5474 27.4

o-Toluidine 20 .39 1.5728 6.34

o-Xylene 16/20 .876/.810 1.5055 2.568

Propyl Bromide 20 .524 1.4341 7.2

Propylene Glycol (100%) 20/40 56/18 1.433

Propylene Glycol (30%) 20/30 3.0/2.1 1.367

Propylene Glycol (20%) 20/30 2.18/1.59 1.355

Propylene Glycol (10%) 20/30 1.5/1.2 1.344

p-Toluidine 20 80 1.5532 6.0

p-Xylene 16/20 .696/.648 1.4958 2.27

Pyridine 20 .95 1.5102 12.5

Sec-Butyl Alcohol 25/50 3.096/1.332 1.3954 15.8

Styrene (Vinyl Benzene) 20/50 .749/.502 1.55 2.4

Sulphuric Acid 20 .254 1.8430 84

Tert-Butyl Alcohol 25/50 4.312/1.421 1.3847 11.5

Tetrachloroethylene 15 .93 1.5044 2.5

Table B.1  Other Liquids (Continued)

Liquid T(C) (CP) R.I. Dielectric 
Constant
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Liquid viscosity values in the third column are at the corresponding temperatures in the second 
column. Refractive indices are at the sodium yellow line ( = 589.3 nm) at 20 C. Dielectric constants 
are at 20 C. The values are from the CRC Handbook of Chemistry and Physics, CRC Press, Boca Raton, 
1999.

Tetradecane 20/50 2.31/1.32 1.429

Tetrahydrofuran 20/30 .575/.525 1.40 7.6

Toluene 20/30 .590/.526 1.4969 2.4

Trichloroethane 20 .2 1.4377 7.5

Trichloroethylene 20 .57 1.4784 3.4

Triethylamine 25/50 .347/.273 1.4003 2.4

Water 20/25 1.002.8904 1.3330 80.2

Table B.1  Other Liquids (Continued)

Liquid T(C) (CP) R.I. Dielectric 
Constant
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APPENDIX C

Alpha and Beta Values
Introduction

The alpha (a) and beta (b) constants are determined separately for each component. The following 
table provides a list of a and b values for a select number of polymers.

Table C.1  Alpha and Beta Values

Sample Solvent Temp. 
(°C)

Alpha Beta

cis-4 Polybutadiene Hexatriacontan 80 1.45´10-4 0.561

Methyl cellulose Water 20 0.79´10-4 0.56

Poly(1,4-benzamide) Dimethylacetamide 25 4.38´10-4 0.82

Poly(1-hexene sulfone Acetone 20 3.0´10-4 0.71

Poly(1-p-tolyl-2,5-dioxopyrrolidin-3,4-
diyl)

Dimethylformamide 21 3.47´10-3 0.58

Poly(3-methyl-1-butene silsesquioxane) Butyl acetate 24 1.1´10-3 0.69

Poly(acrilonitrile) Dimethylformamide 25 3.2´10-4 0.63

Poly(acrylamide) Water 20 8.46´10-4 0.69

Poly(acrilonitrile) Dimethylformamide 35 7.8´10-4 0.63

Poly(butadiene co-acrylonitrile) Hexane 22 1.38´10-4 0.5

Poly(butadiene) linear Dioxane 25 6.34´10-5 0.496

Poly(butyl methacrylate) 2-propyl alcohol 21.5 6.3´10-5 0.5

Poly(cetyl methacrylate) Heptane 21 1.74´10-3 0.64

Poly(cholesteryl acrylate) Benzene 21 3.2´10-4 0.54

Poly(ethyl acrylate-co-acrylic-acid) Water/NaCl (0.05 mol/
dm3)

5.76´10-4 0.65

Poly(ethyl acrylate-co-acrylic-acid) Water/NaCl (0.05 mol/
dm3)

1.54´10-4 0.52

Poly(ethyl acrylate-co-acrylic-acid) Water/NaCl (1.0 mol/dm3) 1.24´10-4 0.5

Poly(G-benzyl-L-glutamate) Dimethylformamide 21 2.8´10-3 0.8

Poly(isobutene) Heptane 25 5.01´10-4 0.555

Poly(isobutene) Octane 20.9 5.01´10-4 0.555
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Determining alpha and beta

Photon correlation spectroscopy (PCS) is an indirect means of determining the molecular weight of 
polymeric samples, such as proteins, polymers, and colloidal particles. The principle of using PCS to 
determine the molecular weight of a sample in solution or in suspension is based on the empirical 
relationship between the molecular weight (Mw) and the translation diffusion coefficient (DT) of the 
sample:

Equation 20

The two constants in this empirical equation represent the structural effect (the parameter a) and 
the solvent effect (the parameter b), respectively, on the translational motion of the molecules (or 

Poly(isoprene) Chloroform 20 3.5´10-4 0.42

Poly(isoprene) (18-armed star) Carbon tetrachloride 50 1.33´10-8 0.57

Poly(isoprene) (4-armed star) Carbon tetrachloride 50 1.17´10-8 0.61

Poly(isoprene) (linear) Carbon tetrachloride 5 1.54´10-8 0.54

Poly(isoprene) (linear) Carbon tetrachloride 50 1.3´10-8 0.61

Poly(isoprene) 1,4-cis Hexane 20 3.98´10-2 0.55

Poly(methyl methacrylate) n-butyl chloride 35.6 9.6´10-4 0.59

Poly(methyl methacrylate) Ethyl acetate 20 1.61´10-4 0.48

Poly(m-phenylene isophthalamide) Dimethylacetamide 26 1.13´10-4 0.56

Poly(m-phenylene isophthalamide) Dimethylacetamide/3% 
LiCI

25 0.55´10-4 0.56

Poly(n-butyliminocarbonyl) Tetrahydrofuran 20 1.69´10-4 0.85

Poly(N-isopropyl methacrylate) Water 20 2.02´10-4 0.57

Poly(oxydiphenylsilylene) Benzene 21 6.16´10-4 0.63

Poly(p-
carbethoxyphenylmethacrylamide)

Ethyl acetate 21 2.8´10-4 0.69

Poly(p-ethoxycarbonyl 
phenylmethacrylate)

Ethyl acetate 2.8´10-4 0.69

Poly(styrene) Methyl ethyl ketone 25 3.1´10-4 0.53

Poly(styrene) Toluene 20 unknown 0.53

Poly(styrene) NBS 419 Cyclohexane 35 1.21´10-4 0.5

Poly(styrene) NBS 705 Methyl ethyl ketone 25 1.96´10-4 0.49

Table C.1  Alpha and Beta Values (Continued)

Sample Solvent Temp. 
(°C)

Alpha Beta
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particles). For polydisperse samples, the obtained molecular weight is an ill-defined mean value 
that may not be the same as the mean values obtained by other means.

The values of a and b can be obtained from literature or experimentally. There are listings of a and 
b values in the DelsaNano and in the Polymer Handbook and CRC Physical Chemistry Handbook. The 
values are only valid for the specific molecules (or particles) in the specific solvent (or dispersing 
medium) and temperature, although the temperature variation may be minimal in the normal 
temperature range. If the literature values are not available, a and b can be obtained experimentally 
with the DelsaNano using the following procedure, provided that two (or more) samples of known 
molecular weight are available.

Procedure

NOTE This procedure is executed outside the DelsaNano software.

1 Obtain two or more (preferably monodisperse) samples of the same type with known molecular 
weight values. These samples are going to be used as the “standards.” The molecular weight 
range of these standards should be wider than or similar to the range of the unknown samples.

2 Make solutions (or suspensions) of these standards using the same solvent and at the same 
temperature that are to be used for the unknown samples.

3 Select Yes to Molecular Weight Calculation in the Analysis Parameters panel of the Size SOP 
Designer. Enter alpha = 1 and beta = 1.

4 Make good measurements of the standard samples and use the Cumulants analysis to obtain the 
molecular weight. The obtained values are called the apparent molecular weight Mw.app.

5 Plot Log(Mw) versus Log(Mw.app) for all standards and do a linear least-square fitting.

6 The a and b values can then be obtained from the following equations:

Equation 21

Equation 22

Explanation: The above procedure is based on Equation 20. In Equation 20, if a = 1 and b = 1, then 
Mw.app = 1/DT. When plotting in the logarithmic scale, Log(Mw) = 1/bLog(a)-1/bLog(Mw.app). 
Therefore, Slope = -1/b; and Intercept = 1/bLog(a).
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References for Alpha and Beta Values

1. Kramer O. and Frederick, JE., 1971. Macromolecules 4:613.

2. Poddubnyi IY, Podalinski AV, and Grechanovskii VA; 1966. Vysokomolekul Soedin 8: 1556

3. Brandrup J., Immergut EH., Grylke EA., 1999. Polymer Handbook, fourth edition. Wiley & Sons, 
Inc.
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APPENDIX D

Graphs and Table Displays
Introduction

This appendix includes descriptions and examples of the following: 

 • Realtime Size Monitor

 • Realtime Size Table

 • Differential Intensity Distribution Graph

 • Cumulative Intensity Distribution Graph

 • Differential Volume Distribution Graph

 • Cumulative Volume Distribution Graph

 • Differential Number Distribution Graph

 • Cumulative Number Distribution Graph

 • Ln(G1(t)) Plot Graph

 • Differential Size Distribution Table

 • Cumulative Size Distribution Table

 • ACF Listing

 • Condition Summary

 • Distribution Graph with Zeta Potential of the Sample

 • Distribution Graph with Mobility of the Sample

 • ACF (Base)

 • Test Measurement

 • 3D Graph

 • Peak Value Table

 • Graph display adjustments options
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Realtime Size Displays

Realtime Size Monitor

This shows the stability of the sample during measurement.

Figure D.1  Realtime Size Monitor

Realtime Size Table

This shows the realtime size data (raw) in tabular form.
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Figure D.2  Realtime Size Table

Intensity Distribution Graphs

Photon correlation spectroscopy (PCS) directly measures intensity (weighted) size distributions, 
displayed as intensity histograms in the DelsaNano. In these histograms, the magnitude of each 
peak is proportional to the percent (% amount of the total scattered intensity due to particles. For 
example, in the graph below, the intensity distribution peak average is shown as 100.9 ±-25.0 nm. 
The DelsaNano measures intensity distributions and optionally converts them to volume or number 
distributions.
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Figure D.3  Differential Intensity Distribution

Figure D.4  Cumulative Intensity Distribution
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Volume Distribution Graphs

Volume distributions (same as weight distributions) give the relative volume of particles of each size 
in a sample. In addition, intensity results are dependent on scattering angle; volume results are not. 
The following graph represents the volume distribution for the same sample shown in Figure D.3. 
For example, in the graph below, the volume distribution peak average is shown as 84.7 ±20.3 nm.

The corresponding percent (% amount) in each bin and cumulative percent (% amount) can be 
obtained from the size distribution table and cumulative size distribution table, respectively.

Figure D.5  Differential Volume Distribution
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Figure D.6  Cumulative Volume Distribution

Number Distribution Graphs

Number percentage (%) distributions are determined by dividing the volume percentage results by 
the cubed diameter of the particles in the distribution. The following graph represents the number 
distribution for the sample shown in Figure D.3. For example, in the graph below, the number 
distribution peak average is shown as 73.6 ±15.2 nm.

The corresponding percent (% amount) in each bin and cumulative percent (% amount) can be 
obtained from the size distribution table and cumulative size distribution table, respectively.
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Figure D.7  Differential Number Distribution

Figure D.8  Cumulative Number Distribution
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Ln(G2(t)-1 Plot

This shows the natural logarithmic graph of (G2(t)-1) vs. decay time. This indicates if there is any 
noise in the signal. The curve should be smooth where the ACF exists and become noisy where the 
ACF touches the baseline.

Figure D.9  Ln(G2(t)-1) Plot
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Size Distribution Tables

The differential and cumulative graphs are available in tabular form. In this form, the data is 
separated into a select number of bins spaced along your selected size range. The listings give the 
size corresponding to each bin and the relative amount of scattered intensity in each bin. The total 
intensity adds up to 100%. The absolute percentages appearing in the tabular data do not directly 
correspond to the absolute percentages appearing in the graphs because the graphs are also scaled 
to total 100%, and they contain more bins than the tabular form.

Differential Size Distribution Table

Figure D.10  Differential Size Distribution Table
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Cumulative Size Distribution Table

Figure D.11  Cumulative Size Distribution Table
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ACF Listing

This presents the Autocorrelation Function (ACF) raw data in tabular form.

Figure D.12  ACF Listing

Normal and abnormal correlation functions are shown in the examples that follow.

Figure D.13  Normal Linear ACF
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In the ACF with short sampling time example below, the sampling time has to be increased.

Figure D.14  ACF with Short Sampling Time

Figure D.15  Normal Log ACF
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Figure D.16  ACF Noisy - Low Sample Concentration

Figure D.17  ACF for Small Particles (Less than 10 mm)

Condition Summary

This presents the summary of the measurement, analysis, cell, and diluent conditions.
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Distribution Graphs  
Figure D.18  Condition Summary

Distribution Graphs

Distribution graph is plotted between Intensity, Mobility/Zeta Potential and Frequency. You can 
view the graph at all positions at which the zeta potential/mobility is measured. The positions are 
set in the Cell Parameters of the Zeta SOP Designer. See CHAPTER 1, Operation.

To change the position, select the desired position from the Select Relative Position drop-down 
menu at the top of the graph.

To switch from Zeta Potential to Mobility, click Mobility at the top of the graph. The name of the 
button then changes to Zeta Potential, allowing you to switch back to Zeta Potential.

The pink vertical line represents the Doppler Frequency Shift of the signal from Base Frequency.

The Lorentzian Peak represents the Brownian motion of the particles. The number “1” indicates the 
Lorentzian Peak number.
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Graphs and Table Displays
Distribution Graphs  D
Figure D.19  Distribution Graph with Zeta Potential of the Sample

NOTE In Figure D.19, the blue line indicates raw data, and the red curve indicates fitted data.

The values displayed in the graph below represent the mobility of the sample.
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Graphs and Table Displays
ACF (Base)  
Figure D.20  Distribution Graph with Mobility of the Sample

ACF (Base)

The Electrophoretic Mobility of the sample is determined by using heterodyne type of 
measurement. The measurement requires a reference signal, the Base, whose frequency is 
compared with the scattered laser light frequency from the sample and the Doppler Shift 
(modulator signal) is calculated.

The Base frequency is dependent on the type of cell used and the concentration of the sample. 
Typically, for Flow cell, Disposable Zeta cell, Low Conductivity and Flat Surface cell, the Base 
frequency varies between 110-140 Hz, and for High Concentration cell, the Base frequency varies 
between 220-270 Hz.

If the cell center is not appropriate, you may not get a good ACF for Base measurement. In that case, 
the cell center of the cell can be detected before carrying out the analysis.
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Graphs and Table Displays
Test Measurement  D
Figure D.21  ACF Base

Test Measurement

This is a preliminary test the instrument performs to determine the sign of the polarity to be 
applied to the sample. The test measurement consists of ACF and Power Spectrum. After analysis, 
the test results are displayed. For example:

 • Positive Test Results: -12.5

 • Negative Test Results: 15.8

 • Polarity: (-) Negative

This decision is based on the Doppler Shift in the frequency. To interpret the results, assume the sign 
of polarity that is to be determined as “x.” When “x” is multiplied with a positive value to get a 
negative result (-12.5), “x” has to be negative. Similarly, when “x” is multiplied with a negative value 
to get a positive result (15.8), “x” has to be negative. As a result, the sign of polarity is negative (-).
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Graphs and Table Displays
3D Graph  
Figure D.22  ACF and Power Spectrum of Test Measurement

3D Graph

This provides the electroosmotic velocity profile of the sample.

This is a graph plotted between Intensity, Mobility/Zeta Potential, and Frequency. 

The graph can be viewed at all positions at which the zeta potential/mobility is measured, including 
a Set Rate where you can change the height/peak/stationary layers. The positions can be set in the 
Cell parameters of the Zeta SOP Designer or selected under the Set Rate drop down menu.

To switch from Zeta Potential to Mobility (or Mobility to Zeta Potential), click Mobility /
Zeta Potential  at the top of the graph. To change the view, click TOP / 3D .
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Graphs and Table Displays
3D Graph  D
Figure D.23  3D Graph with Zeta Potential and Top View

The Lorentzian Peak represents the Brownian motion of the particles, as shown in Figure D.24.
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Graphs and Table Displays
Peak Value Table  
Figure D.24  3D Graph with Mobility and 3D View

Peak Value Table

This provides the mobility, zeta potential of the sample, and the electric field applied.

This also provides apparent mobility and zeta potential peak values at the locations specified in the 
cell condition of the Zeta SOP Designer (for example, 5 locations for flow cell).

The Peak Edit feature allows you to select the peaks for analyzing data zeta potential.
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Graphs and Table Displays
Peak Value Table  D
Figure D.25  Peak Value Table
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Graphs and Table Displays
Graph Display Adjustment Options  
Peak Edit Feature

The Peak Edit feature allows you to select the peaks for analyzing data zeta potential. To adjust the 
values, click Peak Edit in the Peak Value Table and select or deselect the desired peaks.

Graph Display Adjustment Options

The options for adjusting graph displays are in pop-up menus.

To adjust features on the X and Y axes, place the cursor on the desired axis, and right-click to open 
the menu (Figure D.26).
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Graphs and Table Displays
Graph Display Adjustment Options  D
Figure D.26  Y Axis Pop-Up Menu

To add or edit features in the graph, place the cursor in the graph, and right-click to open the 
Toolbar pop-up menu (Figure D.27).
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Graphs and Table Displays
Graph Display Adjustment Options  
Figure D.27  Graph Toolbar Pop-Up Menu
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APPENDIX E

Upgrading the DelsaNano Software
Introduction

This appendix describes how to install the DelsaNano software to upgrade to a newer version or to 
reinstall the software. You must be an Administrator.

Upgrading or Reinstalling the DelsaNano Software

The instructions in this sections are provided in case you need to reinstall or upgrade the software.

CAUTION

The data files appear in the software under Data Select Panel as long as the 
software is installed in the same original folder, however, the system parameters 
are deleted. It is also very important to backup the data and update the system 
parameters after upgrading or installing the DelsaNano software.

1 Insert the DelsaNano software CD into the CD/DVD drive of your computer. The Install window 
opens.
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Upgrading the DelsaNano Software
Upgrading or Reinstalling the DelsaNano Software  
Figure E.1  Install Window

2 If you are reinstalling/upgrading the software, select the appropriate DelsaNano model under 
the New Installation/Upgrade option, and click Install. The software is installed in the selected 
folder on the computer. The installation progress appears.

When the DelsaNano software has been installed successfully, a confirmation message appears 
(Figure E.2).

Figure E.2  Installation Complete Window

3 Click Finish  to close the window.
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Upgrading the DelsaNano Software
Upgrading or Reinstalling the DelsaNano Software  E
4 From Windows, double-click the DelsaNano icon on the computer desktop, or select the 
program from your program list. If you are upgrading to a newer version, a message appears 
briefly, and then the upgrade commences.

During upgrade, the progress appears. When the upgrade is finished, the software is ready to 
use, and the DelsaNano Main screen appears.
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Beckman Coulter, Inc.
Customer End User License Agreement

This Product contains software that is owned by Beckman Coulter, Inc. or its suppliers and is protected by 
United States and international copyright laws and international trade provisions. You must treat the 
software contained in this Product like any other copyrighted material. This license and your right to use the 
Product terminate automatically if you violate any part of this agreement.

This is a license agreement and not an agreement for sale. Beckman Coulter hereby licenses this Software to 
you under the following terms and conditions:

You May:
 • Use this software in the computer supplied to you by Beckman Coulter;
 • Maintain one copy of this software for backup purposes (the backup copy shall be supplied by Beckman 

Coulter);
 • After written notification to Beckman Coulter, transfer the entire Product to another person or entity, 

provided you retain no copies of the Product software and the transferee agrees to the terms of this 
license agreement.

You May Not:
 • Use, copy or transfer copies of this Software except as provided in this license agreement;
 • Alter, merge, modify or adapt this Software in any way including disassembling or decompiling;
 • Loan, rent, lease, or sublicense this Software or any copy.

Limited Warranty
Beckman Coulter warrants that the software will substantially conform to the published specifications for the 
Product in which it is contained, provided that it is used on the computer hardware and in the operating 
system environment for which it was designed. Should the media on which your software arrives prove 
defective, Beckman Coulter will replace said media free of charge within 90 days of delivery of the Product. 
This is your sole remedy for any breech of warranty for this software.

Except as specifically noted above, Beckman Coulter makes no warranty or representation, either expressed 
or implied, with respect to this software or its documentation including quality, performance, 
merchantability, or fitness for a particular purpose.

No Liability for Consequential Damages
In no event shall Beckman Coulter or its suppliers be liable for any damages whatsoever (including, without 
limitation, damages for loss of profits, business interruption, loss of information, or other pecuniary loss) 
arising out of the use of or inability to use the Beckman Coulter Product software. Because some states do not 
allow the exclusion or limitation of liability for consequential damages, the above limitation might not apply 
to you.

General
This agreement constitutes the entire agreement between you and Beckman Coulter and supersedes any prior 
agreement concerning this Product software. It shall not be modified except by written agreement dated 
subsequent to the date of this agreement signed by an authorized Beckman Coulter representative. Beckman 
Coulter is not bound by any provision of any purchase order, receipt, acceptance, confirmation, 
correspondence, or otherwise, unless Beckman Coulter specifically agrees to the provision in writing. This 
agreement is governed by the laws of the State of Florida.
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